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Introducción 1
La información contenida en este manual está destinada a dos tipos principales de usuarios:

• El administrador del laboratorio, que es el responsable del funcionamiento y uso diario del
software Analyst MD y la instrumentación conectada desde un punto de vista funcional.

• El administrador del sistema, que se encarga de la seguridad del sistema y la integridad y
los datos del sistema.

Introducción
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Descripción general de la
configuración de seguridad 2
En esta sección se describe la forma en que los componentes de control de acceso y
auditoría del software Analyst MD trabajan en colaboración con los componentes de control
de acceso y auditoría de Windows. Además, describe cómo configurar la seguridad de
Windows antes de instalar el software Analyst MD.

Seguridad y cumplimiento normativo
Requisitos de seguridad
Los requisitos de seguridad varían en función de su aplicación, es decir, si se trata de
entornos relativamente abiertos, como laboratorios de investigación o académicos, o de
entornos estrictamente regulados, como los laboratorios clínicos.

Analyst MD y sistema de seguridad de Windows:
funcionamiento conjunto
El software Analyst MD y el NTFS (sistema de archivos de nueva tecnología) de Windows
disponen de funciones de seguridad diseñadas para controlar el acceso al sistema y a los
datos.

El sistema de seguridad de Windows proporciona un nivel de protección superior, ya que
obliga a los usuarios a iniciar sesión en la red mediante una identificación de usuario y
una contraseña únicas. Como resultado, solo los usuarios reconocidos por la configuración
de seguridad de Windows local o de la red tienen acceso al sistema. Para obtener más
información, consulte la sección Configuración del sistema de seguridad de Windows.

El software Analyst MD ofrece tres modos de acceso al sistema, cuya seguridad aumenta de
uno a otro:

• Modo de usuario único

• Modo mixto

• Modo integrado (predeterminado)

Para obtener más información sobre los modos y la configuración de seguridad, consulte la
sección Acerca de los modos de seguridad y las cuentas.

El software Analyst MD también proporciona funciones completamente configurables que
son independientes de los grupos de usuarios asociados a Windows. Mediante el uso de
funciones, el director de laboratorio puede controlar el acceso al software y al espectrómetro
de masas a través de las funcionalidades disponibles para cada función. Para obtener más
información, consulte la sección Acceso al software Analyst MD .

Descripción general de la configuración de seguridad
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Pistas de auditoría en el software Analyst MD y Windows
Las funciones de auditoría del software Analyst MD, junto con los componentes de
auditoría integrados de Windows, son fundamentales para la creación y gestión de registros
electrónicos.

El software Analyst MD proporciona un sistema de pistas de auditoría que cumple los
requisitos de generación de registros electrónicos. Estas pistas de auditoría independientes
registran:

• Los elementos agregados o reemplazados en las tablas de resoluciones o de calibración
de masas, los cambios en la configuración del sistema, los eventos de seguridad y las
entradas realizadas en el registro de mantenimiento del instrumento.

• La creación y modificación de eventos para proyectos, ajuste, lotes, datos, métodos de
adquisición, métodos de cuantificación, tablas de resultados y archivos de plantilla de
informe, así como eventos de apertura y cierre de módulos y de impresión. Los eventos
de eliminación registrados en la pista de auditoría son la eliminación de instrumentos para
el visor remoto, la eliminación de usuarios en el software Analyst MD, la eliminación de
tipos de usuarios y la eliminación de funciones del proyecto.

• La creación y modificación del método de cuantificación integrado en la tabla de
resultados, la modificación de la información de muestras en la tabla de resultados y
la modificación de los parámetros de integración de picos.

Para ver una lista completa de los eventos de auditoría, consulte la sección Registros de
pistas de auditoría.

El software Analyst MD utiliza el registro de eventos de la aplicación para recopilar
información sobre el funcionamiento del software. Utilice este registro como ayuda para
solucionar problemas, ya que en él se registra información detallada de las interacciones
entre el espectrómetro de masas, el dispositivo y el software.

Windows conserva registros de eventos que recopilan una amplia variedad de eventos
relacionados con la seguridad, el sistema y la aplicación. En la mayoría de los casos, la
función de auditoría de Windows está diseñada para registrar eventos inusuales, como los
fallos de inicio de sesión. El administrador puede configurar este sistema para registrar
diferentes tipos de eventos, entre ellos, el acceso a archivos específicos o actividades
administrativas de Windows. Para obtener más información, consulte la sección Auditorías
del sistema.

Pistas de auditoría del software MultiQuant MD
El software MultiQuant MD contiene su propia pista de auditoría que audita los eventos de
creación y modificación dentro del software MultiQuant MD. La funcionalidad de pista de
auditoría solo está disponible con la licencia 21 CFR Part 11 del software MultiQuant MD.

21 CFR Parte 11
El software Analyst MD contiene los controles técnicos para cumplir la norma 21 CFR Parte
11 con la implementación de:

• Modos de seguridad mixto e integrado asociados al sistema de seguridad de Windows.

Descripción general de la configuración de seguridad
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• Acceso controlado a las funcionalidades mediante la asignación de funciones
personalizables.

• Acceso controlado a datos de proyectos basándose en la función o el grupo.

• Pistas de auditoría para el funcionamiento del instrumento, el mantenimiento, la
adquisición y revisión de datos y la generación de informes.

• Firmas electrónicas con una combinación de ID de usuario y contraseña.

• Configuración adecuada del sistema operativo Windows.

• Procedimientos y formación apropiada en la empresa.

El software Analyst MD está diseñado para utilizarlo como parte de un sistema conforme a
la norma 21 CFR Parte 11 y se puede configurar para adecuarse al cumplimiento de dicha
norma. Que el uso del software Analyst MD cumpla la norma 21 CFR Parte 11 depende del
uso y configuración real del software Analyst MD en el laboratorio.

Los servicios profesionales de SCIEX ofrecen servicios de validación. Para obtener más
información, póngase en contacto con complianceservices@sciex.com.

Configuración del sistema
La configuración del sistema suelen llevarla a cabo administradores de red o usuarios con
derechos de administración local y de red.

Configuración del sistema de seguridad de Windows
Para poder utilizar el software Analyst MD para gestionar la seguridad, el administrador debe
poder cambiar los permisos de archivo para la carpeta del proyecto y todas sus subcarpetas.
Si el directorio principal se encuentra en un equipo local, el administrador del software puede
formar parte del grupo de administradores locales. En el grupo de administradores locales
tan solo debe encontrarse el usuario del software Analyst MD responsable de gestionar la
seguridad.

Para que el software Analyst MD funcione de la forma prevista, los usuarios deben ser
miembros del grupo de usuarios locales de Microsoft Windows.

Nota: La adquisición en red no es compatible con el software Analyst MD.

Usuarios y grupos
El software Analyst MD utiliza los nombres de usuario y las contraseñas registradas en la
base de datos de seguridad del controlador de dominio principal o en Active Directory. Las
contraseñas se gestionan mediante las herramientas proporcionadas con Windows. Para
obtener más información sobre añadir y configurar personas y funciones, consulte la sección
Acceso al software Analyst MD .

Descripción general de la configuración de seguridad
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Compatibilidad con Active Directory
Active Directory funciona en entornos nativos y mixtos. En la ventana de configuración de
seguridad del software Analyst MD y la base de datos de seguridad del software Analyst MD,
especifique cuentas de usuario en formato UPN (nombre principal de usuario).

Entorno mixto
Si el software Analyst MD se inicia en el entorno mixto, la ventana de inicio de sesión
contiene los campos de nombre de usuario, contraseña y dominio.

La red incluye lo siguiente:

• Servidores Windows 2008 R2 y 2012.

• Clientes Windows 10 de 64 bits.

Entorno nativo
Si el software Analyst MD se inicia en el entorno nativo, no se muestra el campo de dominio.
Además, el software Analyst MD únicamente acepta el nombre de usuario en formato UPN.
La ventana Status del software Analyst MD también muestra el nombre de usuario en
formato UPN.

La red incluye lo siguiente:

• Servidores Windows 2008 R2 y 2012.

• Clientes Windows 10 de 64 bits.

Sistema de archivos de Windows
En el software Analyst MD, los archivos y directorios deben estar almacenados en una
partición del disco duro formateada en NTFS donde se pueda controlar y auditar el acceso
a los archivos del software Analyst MD. El sistema de tabla de asignación de archivos (FAT)
no puede controlar ni auditar el acceso a las carpetas o los archivos y, por lo tanto, no es
adecuado para proporcionar un entorno seguro.

Auditorías del sistema
Se puede habilitar la función de auditoría del sistema Windows para detectar brechas
de seguridad o intrusiones en el sistema. Las auditorías se pueden establecer para que
registren diferentes tipos de eventos relacionados con el sistema. Por ejemplo, se puede
habilitar la función de auditoría para registrar en el registro de eventos cualquier intento de
inicio de sesión correcto o incorrecto para acceder al sistema.

Permisos de archivos y carpetas
Para gestionar la seguridad en una unidad de red, el administrador del software Analyst MD
debe disponer del privilegio para cambiar los permisos de la carpeta Analyst Data y todas
sus subcarpetas. El acceso debe configurarlo el administrador de red.

Descripción general de la configuración de seguridad
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Antes de seleccionar los eventos o las acciones objeto de auditoría, debe definir los
permisos para los archivos y las carpetas. Los permisos para las carpetas se pueden
aplicar a las subcarpetas y archivos de cada carpeta. Una vez establecidos los permisos
de archivos y carpetas, defina los eventos que deben registrarse en el registro de seguridad.

Nota: Tenga en cuenta el nivel de acceso que necesitan los usuarios para la unidad y
la carpeta en cada ordenador. Configure las opciones de uso compartido y los permisos
asociados. Para obtener más información sobre el uso compartido de archivos, consulte la
documentación de Windows.

Para obtener información sobre los permisos para los archivos y carpetas del software
Analyst MD, consulte la sección Configuración de seguridad del software Analyst MD.

Registros de eventos
Abra el Visor de eventos de Windows desde el software Analyst MD o desde Herramientas
administrativas de Windows. El Visor de eventos de Windows registra los eventos auditados
en el registro de seguridad, el registro del sistema y el registro de la aplicación.

Sugerencia: Para abrir el Visor de eventos desde el software Analyst MD, haga clic en View
> Event Log..

Personalice los registros de eventos de la forma siguiente:

• Configurar un tamaño adecuado de registro de eventos.

• Habilitar la sobrescritura automática de eventos antiguos.

• Ajustar la configuración de seguridad del equipo de Windows.

Es posible implementar un proceso de revisión y almacenamiento. Para obtener más
información sobre la configuración de seguridad y las directivas de auditoría, consulte la
documentación de Windows.

Alertas de Windows
Configure la red para que se envíe un mensaje automático a una persona específica, como
el administrador del sistema, en caso de que se produzca un problema relacionado con el
sistema o el usuario en el mismo ordenador o en ordenadores distintos.

• Tanto en el ordenador emisor como en el receptor, inicie el messenger en el panel de
control de Servicios de Windows.

• En el ordenador emisor, inicie el servicio Alert en el panel de control de Servicios de
Windows.

Para obtener más información acerca de cómo crear un objeto de alerta, consulte la
documentación de Windows.

Descripción general de la configuración de seguridad
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Licencias electrónicas 3
La licencia electrónica solo puede ser limitada a nodo.

Puede que más adelante se necesite el ID de activación para algún servicio o llamada de
asistencia técnica. Para acceder al ID de activación de la licencia limitada a nodos o basada
en servidor:

• Haga clic en Help > About Analyst, en la ventana del software Analyst MD.

Nota: Asegúrese de renovar la licencia antes de que venza.

Licencias electrónicas
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Configurar las opciones de
seguridad del software Analyst MD 4
En esta sección se explica cómo configurar el software.

Nota: El usuario debe tener privilegios de administrador local para el ordenador en el que se
está instalando el software.

Operaciones de seguridad del software
El software Analyst MD funciona con los componentes de seguridad, aplicación y auditoría
de eventos del sistema de las Herramientas administrativas de Windows.

Configure la seguridad en los siguientes niveles:

• Autenticación de Windows: acceso al ordenador.

• Autorización de Windows: acceso a archivos y carpetas.

• Acceso al software Analyst MD.

• Acceso selectivo a las funcionalidades del software Analyst MD.

• Acceso a proyectos específicos.

• Acceso al estado de la estación de trabajo del instrumento.

Para ver la lista de tareas para configurar la seguridad, consulte la Tabla 4-1. Para ver las
opciones para configurar los distintos niveles de seguridad, consulte la Tabla 4-2.

Tabla 4-1: Flujo de trabajo para la configuración de seguridad

Tarea Procedimiento

Instalar el software Analyst MD. Consulte el documento Guía de instalación
del software Analyst MD.

Configurar la seguridad del software
Analyst MD.

Consulte la sección Configuración de
seguridad del software Analyst MD.

Configurar las pistas de auditoría. Consulte la sección Auditoría.

Configurar el sistema de seguridad de
archivos y el sistema NTFS de Windows.

Consulte la sección Establecer el acceso.

Registrar los eventos de mantenimiento del
instrumento, el proyecto, la seguridad, los
datos en el registro de mantenimiento del
sistema.

Consulte la sección Personalización
adicional de la seguridad.

Configurar las opciones de seguridad del software Analyst MD
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Tabla 4-2: Opciones de configuración de seguridad

Opción CFR 21 Parte 11

Seguridad de Windows

Formatear las unidades en NTFS. Sí

Configurar usuarios y grupos. Sí

Habilitar auditoría de Windows y auditoría de archivos y directorios. Sí

Definir permisos de archivos. Sí

Instalación del software Analyst MD

Instalar el software Analyst MD. Sí

Instalar el software MultiQuant MD. Sí

Seleccionar las opciones de auditoría. Sí

Visor de eventos (revisar instalación). Sí

Seguridad del software Analyst MD

Seleccionar el modo de seguridad.
Nota: No se recomienda utilizar el modo de usuario único en entornos
que deban cumplir la norma CFR.

Integrado o
mixto

Configurar las funciones y los usuarios de Analyst MD. Sí

Crear mapas de auditoría y configurar las pistas de auditoría del
instrumento, el proyecto y la cuantificación.

Sí

Configurar la función de notificación de correo electrónico. Sí

Activar suma de comprobación.
Nota: La función de suma de comprobación está activada de forma
predeterminada en una instalación nueva del software Analyst MD.

Sí

Tareas comunes

Agregar proyectos y subproyectos nuevos. Sí

Configurar la pista de auditoría de proyecto para proyectos y
subproyectos nuevos.

Sí

Transferir los datos existentes. Sí

Crear el registro de mantenimiento para el mantenimiento del
instrumento, la seguridad, los datos y el proyecto.

Sí

Instalación del software Analyst MD
Antes de instalar el software Analyst MD, lea estos documentos, que están disponibles en
el DVD de instalación del software o el paquete de descarga web: Guía de instalación del

Configurar las opciones de seguridad del software Analyst MD
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software y Notas de la versión. Asegúrese de comprender la diferencia entre un ordenador
de procesamiento y un ordenador de adquisición y, a continuación, lleve a cabo la secuencia
de instalación correspondiente.

Nota: Recomendamos que se deshabiliten las características de actualización y
conectividad a Internet de Windows en el ordenador para evitar que se modifiquen los
componentes de Windows. Si no se deshabilitan las actualizaciones y la conectividad a
Internet, será necesario validar el sistema tras las actualizaciones de Windows o .NET
Framework. Para el ordenador de adquisición, recomendamos encarecidamente que solo
se instalen actualizaciones críticas de Windows (por ejemplo, cambios de seguridad).
Asegúrese de que el sistema dispone de la protección antivirus apropiada para evitar que los
virus dañen sus funcionalidades.

Requisitos de Windows
• Este software solo es compatible con las versiones en inglés de los sistemas operativos

Windows 10. Si se usa un idioma diferente, puede que el software muestre de forma
incorrecta la información de los archivos o de la pista de auditoría.

• En la configuración de Region and Language, asegúrese de que English (United States)
se haya definido como primer idioma.

Requisitos del sistema
Para ver los requisitos mínimos de instalación, consulte el documento Guía de instalación
del software.

Opciones de auditoría predefinidas
Para ver una descripción de los mapas de auditoría instalados, consulte la sección Mapas
de auditoría instalados. Tras la instalación, el administrador del software Analyst MD puede
cambiar la selección en el módulo de configuración de seguridad o configurar los mapas de
auditoría en el gestor de pistas de auditoría.Analyst MD

Verificación de componentes del software
Una vez instalado el software Analyst MD, un procedimiento de verificación de componentes
de software verifica que se han instalado todos los componentes del software y genera un
informe de instalación. Dicho informe es un elemento del registro de eventos del programa
de instalación de Analyst MD, que se encuentra en el registro de la aplicación del visor
de eventos. Compruebe que la instalación se ha llevado a cabo correctamente en cuanto
finalice.

Existe un registro de eventos para la revisión de la detección de errores de los archivos
principales instalados. Para obtener más información sobre la suma de comprobación,
consulte la sección Suma de comprobación de archivos de datos.

1. Haga clic en Start > Control Panel.

2. Haga doble clic en Administrative Tools y luego en Event Viewer.

3. En la pestaña Tree, haga clic en Application Log.
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4. Haga clic en el evento Analyst Installer en la columna Source.

5. En el mensaje de detalles del evento, en el campo Description, vaya a Total files
verified.
El total de errores debe ser cero.
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Configuración de seguridad del
software Analyst MD 5
En esta sección se explica cómo configurar las opciones de seguridad del software
Analyst MD.

Nota: Los cambios realizados en la configuración de seguridad del software Analyst MD
tendrán efecto tras reiniciar el software Analyst MD.

Pasos para configurar el software Analyst MD
Sugerencia: Cuando realice varias tareas en el cuadro de diálogo Security Configuration,
asegúrese de hacer clic en Apply en cada pestaña para guardar los cambios antes de pasar
a otra pestaña.

Para las tareas generales de configuración del software Analyst MD, consulte la tabla Tabla
5-1

Tabla 5-1: Tareas para configurar el softwareAnalyst MD

Tarea Consulte

Configurar el modo de seguridad. Seleccionar el modo de seguridad.

Configurar las funciones de bloqueo de la
pantalla y cierre de sesión automático (solo
en modo mixto).

Configurar el bloqueo de la pantalla y cierre
de sesión automático.

Configurar la seguridad del proyecto. Establecer el acceso.

Configurar las estaciones de trabajo de los
instrumentos.

Añadir acceso a una estación de trabajo o
Retirar acceso a una estación de trabajo.

Ubicación de la información de seguridad
Si el software Analyst MD se está ejecutando en un único ordenador o en una configuración
de red, toda la información de seguridad se guarda en el archivo SecurityDB.odb en la
siguiente carpeta del ordenador:

• C:\Program Files (x86)\Analyst\Bin

Acerca de los modos de seguridad y las
cuentas
En esta sección se describen las opciones disponibles en la pestaña Security del cuadro de
diálogo Security Configuration.

Configuración de seguridad del software Analyst MD
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Single User Mode: En el modo de usuario único, el usuario que tiene la sesión iniciada
en Windows como administrador del software Analyst MD tiene acceso total a toda la
funcionalidad del software Analyst MD. Todos los usuarios que inicien sesión correctamente
en Windows en el ordenador tienen privilegios de administrador para el software Analyst MD.

Integrated Mode: En el modo integrado, el usuario que tiene la sesión iniciada en Windows
tiene acceso al software Analyst MD, siempre que el usuario de Windows también sea un
usuario válido del software Analyst MD.

Mixed Mode: En el modo mixto, el usuario con sesión iniciada en el software Analyst MD
puede ser el mismo usuario o uno distinto al que tiene una sesión iniciada actualmente en
Windows. Al usuario con sesión iniciada en el software Analyst MD se le puede asignar una
función específica del mismo modo que en el modo integrado. Esto permite usar un inicio de
sesión de grupo en Windows con una contraseña conocida y, al mismo tiempo, requerir al
usuario del software Analyst MD que inicie sesión en Analyst MD con un nombre de usuario
y una contraseña exclusivos y, si es necesario, un dominio.

Si se selecciona el modo mixto, están disponibles las funciones de bloqueo de pantalla y
cierre de sesión automático.

Acquisition Account: la cuenta de adquisición es una cuenta de red que se utiliza para
leer y escribir datos en carpetas del proyecto durante la adquisición normal, pero no durante
el proceso de ajuste. El administrador de red debe proporcionar los derechos de acceso
adecuados para las cuentas de red. La cuenta de adquisición utiliza los derechos de la
cuenta de cliente o la cuenta de administrador de adquisición especial.

Client Account: Esta opción permite utilizar para la adquisición de datos la misma cuenta
que se ha utilizado para iniciar sesión en el software Analyst MD. En el modo integrado,
el usuario con sesión iniciada en Windows también ha iniciado sesión en el software
Analyst MD. En el modo mixto, el usuario de Windows y el usuario del software Analyst MD
pueden ser distintos.

Special Acquisition Administrator Account: no recomendamos la adquisición en red
si se utiliza el software Analyst MD. Esta función está diseñada para utilizarse en un
entorno regulado. El operador debe proporcionar un nombre de usuario, un dominio y
una contraseña para esta cuenta. Una vez que el administrador de red haya configurado
esta cuenta, se podrá utilizar para adquirir datos independientemente del usuario actual del
software Analyst MD. Aunque el usuario actual no disponga de los derechos necesarios
para modificar datos en la carpeta Data, se podría llevar a cabo la adquisición de datos. La
información de la cuenta se almacena cifrada en el registro. Consulte la sección Cuenta de
adquisición especial.

Screen Lock and Auto Logout: por motivos de seguridad, se puede configurar el bloqueo
de la pantalla del ordenador tras un periodo de tiempo de inactividad definido. También
se puede establecer un periodo de tiempo de cierre de sesión automático, tras el cual el
cliente del software Analyst MD. Las funciones de bloqueo de la pantalla y cierre de sesión
automático solo están disponibles en el modo mixto.

Seleccionar el modo de seguridad
1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.
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Figura 5-1: Cuadro de diálogo Security Configuration: pestaña Projects

2. Haga clic en More y luego abra la pestaña Security.
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Figura 5-2: Cuadro de diálogo Security Configuration: pestaña Security

3. En el grupo Security Mode, haga clic en un modo y, a continuación, haga clic en OK.

4. Inicie nuevamente el software Analyst MD.

Seleccionar una cuenta de adquisición
1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.

2. Haga clic en More y luego abra la pestaña Security.

3. En el grupo Acquisition Account seleccione una cuenta de adquisición.

4. Si Special Acquisition Administrator Account está seleccionado, haga lo siguiente:

a. Haga clic en Set Acquisition Account.

b. Escriba los valores para los campos User name, Password y, si es necesario,
Domain y, a continuación, haga clic en OK.

Si se utiliza Active Directory en el entorno nativo, el campo de dominio no está visible y
se puede introducir un nombre de usuario en formato UPN.

5. Haga clic en OK.
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Configurar el bloqueo de la pantalla y cierre de sesión
automático
Cuando la pantalla se bloquea, se abre el cuadro de diálogo Unlock Analyst, que muestra
que el sistema se ha bloqueado, así como el nombre y el dominio del usuario actualmente
conectado. Si también se ha configurado la opción de cierre de sesión automático, se
mostrará además el tiempo restante hasta el cierre de sesión del software Analyst MD. Tan
solo el usuario que haya iniciado sesión, o los usuarios con las funciones de administrador y
supervisor, pueden desbloquear o cerrar el software Analyst MD.

Nota: Screen Lock y Auto Logout están disponibles solo en modo mixto.

1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.

2. Haga clic en More y luego abra la pestaña Security.

3. Haga clic en Mixed Mode.

Figura 5-3: Cuadro de diálogo Security Configuration: pestaña Security

4. Seleccione la casilla Screen Lock.
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5. En el campo Wait, escriba el número de minutos que deben transcurrir hasta que se
bloquee la pantalla.

Nota: Si se habilita el cierre de sesión automático y la pantalla no está bloqueada, el
cliente del software Analyst MD se cerrará transcurrido cierto tiempo. Si se está llevando
a cabo una adquisición de datos, el procedimiento continuará. Sin embargo, si una
tabla de resultados, el editor de método o cualquier otro elemento están abiertos y no
guardados, se perderán los cambios.

6. Si es necesario, seleccione Auto Logout y, en el campo Wait, escriba el número de
minutos que deben transcurrir hasta que se cierre el cliente del software Analyst MD.
El cliente dispone tiene 10 segundos para mover el ratón o pulsar una tecla para cerrar
el cuadro de diálogo Unlock Analyst. Tan solo el usuario que haya iniciado sesión, o los
usuarios con las funciones de administrador y supervisor, pueden desbloquear o cerrar
el software Analyst MD. El cuadro de diálogo Unlock Analyst también indica el tiempo
restante hasta que se cierre la sesión al usuario.

Desbloqueo o cierre de sesión del software Analyst MD
Si está activado el bloqueo de pantalla, se abre el cuadro de diálogo Unlock Analyst una vez
que haya transcurrido el tiempo de bloqueo de pantalla.

Figura 5-4: Cuadro de diálogo de desbloqueo de Analyst

Realice una de las siguientes acciones:

• Para desbloquear la pantalla, escriba el nombre de usuario, si es necesario, y la
contraseña y, a continuación, haga clic en UNLOCK.

• Para cerrar sesión, escriba el nombre de usuario, si es necesario, y la contraseña y, a
continuación, haga clic en LOGOUT.
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Acceso al software Analyst MD
Antes de configurar la seguridad, realice lo siguiente:

• Elimine todos los usuarios y grupos de usuarios innecesarios, por ejemplo, el replicador,
el usuario avanzado y el operador con privilegios de copia de seguridad del ordenador
local y la red.

Nota: Cada ordenador SCIEX está configurado con una cuenta de administrador local,
abservice. El servicio técnico y la asistencia técnica de SCIEX usan esta cuenta para
instalar el sistema, realizar su mantenimiento y ofrecer asistencia. No elimine ni desactive
esta cuenta. Si es necesario eliminar o desactivar la cuenta, prepare un plan alternativo
para acceder a SCIEX y comuníquelo a su representante del servicio técnico.

• Agregue grupos de usuarios que contengan grupos con tareas no administrativas
asignadas.

• Configure los permisos del sistema.

• Cree los procedimientos y directivas de cuentas correspondientes para los usuarios en la
directiva de grupo.

Consulte la documentación de Windows para obtener más información sobre los temas
siguientes:

• Usuarios y grupos, y usuarios de Active Directory

• Directivas de bloqueo de cuentas y contraseñas para cuentas de usuario.

• Directiva de derechos del usuario

Si los usuarios trabajan en un entorno de Active Directory, la configuración de la directiva
de grupo de Active Directory afectará a la seguridad del ordenador. Revise las directivas de
grupo con el administrador de Active Directory como parte de una implementación integral
del software Analyst MD.

Acerca de los usuarios y las funciones
El software Analyst MD restringe el acceso únicamente a personas autorizadas para iniciar
sesión en el ordenador y en el software Analyst MD por medio de su nombre de usuario y
contraseña de Windows, excepto en los casos en que se utilice el modo mixto. El software
Analyst MD no permite que haya varias sesiones activas.

Nota: Las pestañas People y Roles no están disponibles en el modo de usuario único.

Un administrador del software Analyst MD tiene la capacidad de agregar usuarios y grupos
de Windows a la base de datos de seguridad del software Analyst MD. Debe asignarse una
de las seis funciones predefinidas a los usuarios o grupos. O bien, es posible crear nuevas
funciones, si es necesario. Las funciones predefinidas no se pueden eliminar, aunque sí es
posible modificar los derechos correspondientes. Solo pueden acceder a los componentes
del software Analyst MD usuarios con funciones del software Analyst MD.
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Tabla 5-2: Funciones del software Analyst MD

Función Tareas típicas Acceso predefinido

Administrador • Administra el sistema.

• Configura la seguridad.

• Toda la funcionalidad del
software Analyst MD

Analyst • Supervisa el funcionamiento del
espectrómetro de masas.

• Analiza los datos que va a
utilizar el usuario final.

• Método de adquisición

• Aplicación Analyst

• Gestor de pistas de auditoría

• Base de datos de compuestos

• Explorar

• Configuración de hardware

• Cuantificación

• Editor de plantillas de informes

• Cola de muestras

• Ajuste

• Ver estado

Operador Supervisa el uso diario del
sistema, incluido el mantenimiento,
la organización de muestras,
la recopilación de datos y el
procesamiento.

• Método de adquisición

• Aplicación Analyst

• Gestor de pistas de auditoría

• Batch

• Base de datos de compuestos

• Explorar

• ExpressView (configuración
heredada1)

• Configuración de hardware

• Editor de plantillas de informes

• Cola de muestras

• Ajuste

• Ver estado

1 Esta función no es compatible con el software Analyst MD.

Configuración de seguridad del software Analyst MD

Guía del director de laboratorio
IVD-IDV-05-0252-ES-E

Software Analyst MD
25/84



Tabla 5-2: Funciones del software Analyst MD (continuación)

Función Tareas típicas Acceso predefinido

Usuario final • Proporciona muestras.

• Recibe los resultados
procesados.

• Integra los resultados con los
datos de otras aplicaciones.

• Método de adquisición

• Aplicación Analyst

• Gestor de pistas de auditoría

• Base de datos de compuestos

• Explorar

• ExpressView (configuración
heredada1)

• Editor de plantillas de informes

• Ver estado

Revisor QA • Revisa los datos.

• Revisa las pistas de auditoría.

• Revisa los resultados de
cuantificación.

• Aplicación Analyst

• Gestor de pistas de auditoría

• Cuantificación

• Editor de plantillas de informes

• Ver estado

Supervisor Desbloquea el software o cierra la
sesión del usuario.

• Unlock and Logout Application

Acceso al software Analyst MD
Figura 5-5: Cuadro de diálogo Security Configuration
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Tabla 5-3: Analyst MD

Acceso
predefinido

Descripción

Create/save
acquisition
methods

Permite a los usuarios crear y guardar métodos de adquisición.

Open
acquisition
methods as
read-only
(acquire mode)

Permite a los usuarios abrir métodos de adquisición en modo de solo
lectura si las opciones Create/save acquisition methods y Overwrite
acquisition methods están desactivadas.

Overwrite
acquisition
methods

Permite a los usuarios sobrescribir métodos de adquisición.

Tabla 5-4: Acceso a la aplicación Analyst mediante el software Analyst MD

Acceso
predefinido

Descripción

Use Workspace
functions2

Permite a los usuarios utilizar las funciones del área de trabajo.

Create Project Permite a los usuarios crear proyectos.

Copy Project Permite a los usuarios copiar proyectos.

Create Root
Directory

Permite a los usuarios crear un directorio principal.

Set Root
Directory

Permite a los usuarios definir un directorio principal.

Change Project Permite a los usuarios cambiar el proyecto.

Load/Save
Processed Data
Files

Permite a los usuarios cargar y guardar los archivos de datos
procesados.

Lock/Logout
Application

Permite que la aplicación se bloquee automáticamente o que se cierre
la sesión del usuario automáticamente una vez transcurrido el periodo
de inactividad especificado. Esta funcionalidad solo está disponible en el
modo mixto y cuando está seleccionada la opción Screen Lock o Auto
Logout.
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Tabla 5-5: Analyst MD

Acceso
predefinido

Descripción

View Audit Trail
Data

Permite a los usuarios ver los datos de las pistas de auditoría.
Deshabilite el acceso a este permiso para todos los usuarios, excepto
para los administradores.

Change Audit
Trail Settings

Permite a los usuarios modificar la configuración de las pistas de
auditoría.

Maintenance
Log

Permite a los usuarios ver el registro de mantenimiento.

Create or
Modify Audit
Maps

Permite a los usuarios crear o modificar mapas de auditoría.

Tabla 5-6: Acceso a lotes mediante el software Analyst MD

Acceso
predefinido

Descripción

Open existing
batches

Permite a los usuarios abrir lotes existentes.

Create new
batches

Permite a los usuarios crear lotes.

Import Permite a los usuarios importar datos de lotes existentes (archivos mdb
u otros formatos admitidos).

Save batches Permite a los usuarios guardar lotes.

Use template
batches

Permite a los usuarios guardar o abrir lotes de plantilla.

Edit batches Permite a los usuarios editar lotes.

Submit batches Permite a los usuarios enviar lotes.

Add or remove
custom
columns

Permite a los usuarios agregar o quitar columnas personalizadas del
editor de lotes.

Use template
acquisition
methods

Permite a los usuarios utilizar un método de adquisición como plantilla.
Esta opción está disponible en el editor de lotes. Una vez seleccionado
un método, se activa la opción Use as template.

Overwrite
batches

Permite a los usuarios sobrescribir lotes existentes.
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Tabla 5-6: Acceso a lotes mediante el software Analyst MD (continuación)

Acceso
predefinido

Descripción

Overwrite
template
batches

Permite a los usuarios sobrescribir lotes de plantilla existentes.

Tabla 5-7: Acceso a la base de datos de compuestos mediante el software Analyst MD

Acceso
predefinido

Descripción

Setup
compound
database
location

Permite definir las opciones de ubicación y nombre de la base de
datos de compuestos en modo de solo lectura y deshabilita el botón
de navegación. En modo Explore, haga clic en Tools > Settings >
Optimization Options.

Habilita el botón Use Defaults Now en el cuadro de diálogo
Optimization Options únicamente si el usuario tiene acceso tanto a la
ubicación de la base de datos de compuestos como a las opciones de
usuario de la base de datos de compuestos.

Setup user
options

Permite a los usuarios definir las opciones de ID de usuario y contraseña
en el cuadro de diálogo Optimization Options. En modo Explore, haga
clic en Tools > Settings > Optimization Options.

Activa el botón Use Defaults Now del cuadro de diálogo Optimization
Options únicamente si el usuario tiene acceso tanto a la ubicación de
la base de datos de compuestos como a las opciones de usuario de la
base de datos de compuestos. (Haga clic con el botón derecho en la
base de datos de compuestos para acceder a estas funciones).

Add to
compound
database

Permite a los usuarios agregar compuestos a la base de datos de
compuestos. (Haga clic con el botón derecho en la base de datos de
compuestos para acceder a esta función).

Modify
database
(overrides add/
delete if
disabled)

Permite a los usuarios agregar, eliminar o modificar elementos de
la base de datos de compuestos (configuración de compuestos u
optimización).

Delete
compound from
database

Permite a los usuarios eliminar compuestos de la base de datos de
compuestos. (Haga clic con el botón derecho en la base de datos de
compuestos para acceder a esta función).
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Tabla 5-7: Acceso a la base de datos de compuestos mediante el software Analyst MD
(continuación)

Acceso
predefinido

Descripción

Delete
optimization
settings from
database

Permite a los usuarios eliminar la configuración de optimización de la
base de datos de compuestos. (Haga clic con el botón derecho en la
base de datos de compuestos para acceder a esta función).

Tabla 5-8: Analyst MD

Acceso
predefinido

Descripción

Save data to
text file

Permite a los usuarios guardar datos en archivos de texto. (Haga
clic con el botón derecho en un espectro o perfil cromatográfico y, a
continuación, haga clic en Save to Text File).

Setup library
location

Permite a los usuarios configurar o seleccionar la ubicación de la base
de datos de la biblioteca.

Setup library
user options

Permite a los usuarios configurar información de seguridad como el
nombre de usuario y la contraseña para la biblioteca.

Add library
record

Permite a los usuarios agregar un registro de la biblioteca. (Haga clic
con el botón derecho en un espectro o, en el modo de exploración, haga
clic en Explore > Library Search > Add).

Add spectrum
to library
record

Si está desactivado, los usuarios no pueden hacer clic en el botón
Append MS del cuadro de diálogo Library Search. En modo Explore,
haga clic en Explore > Library Search > List.

Modify library
record
(overrides add/
delete if
disabled)

Permite a los usuarios agregar los registros de la biblioteca.

Delete MS
spectrum

Permite a los usuarios eliminar un espectro de MS.

Delete UV
spectrum

Permite a los usuarios eliminar un espectro de UV.

Delete
structure

Permite a los usuarios eliminar una estructura.

View library Permite a los usuarios usar las funciones de lista y lista con limitaciones.
En modo Explore, haga clic en Explore > Library Search.
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Tabla 5-8: Analyst MD (continuación)

Acceso
predefinido

Descripción

Search library Permite a los usuarios utilizar las funciones de búsqueda en biblioteca
y configurar limitaciones de búsqueda. (Haga clic con el botón derecho
en un espectro o, en el modo de exploración, haga clic en Explore >
Library Search).

Select
processing
algorithm to
retrieve peak
list

Configuración heredada2

Tabla 5-9: Analyst MD*

Acceso
predefinido

Descripción

Start Express
View dialog

Configuración heredada2

Modify options Configuración heredada2

Tabla 5-10: Analyst MD

Acceso
predefinido

Descripción

Create Permite a los usuarios crear un perfil de hardware.

Delete Permite a los usuarios eliminar un perfil de hardware.

Edit Permite a los usuarios editar un perfil de hardware.

Activate/
Deactivate

Permite a los usuarios activar o desactivar un perfil de hardware.

Tabla 5-11: Acceso a la cuantificación mediante el software Analyst MD

Acceso
predefinido

Descripción

Create
quantitation
method

Permite a los usuarios crear métodos de cuantificación.

Change default
method options

Permite a los usuarios cambiar las opciones predeterminadas del
método.

2 Esta función no es compatible con el software Analyst MD.
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Tabla 5-11: Acceso a la cuantificación mediante el software Analyst MD (continuación)

Acceso
predefinido

Descripción

Use full method
editor

Permite a los usuarios utilizar el editor de métodos de cuantificación.

Create
“automatic”
methods

Permite a los usuarios crear un método de cuantificación a través del
asistente de cuantificación.

Modify existing
methods

Permite a los usuarios modificar (sobrescribir) métodos de cuantificación
existentes.

Change peak
names (in
wizard)

Permite a los usuarios cambiar nombres de picos en el asistente
Quantitation Wizard.

Change default
number of
smooths (in
wizard)

Permite a los usuarios especificar el número predeterminado de
suavizados en el asistente de cuantificación.

Change
“advanced”
parameters (in
wizard)

Permite a los usuarios cambiar los parámetros de configuración
avanzada en el asistente de cuantificación. Si los usuarios no disponen
de esta opción, el botón Avanzados estará oculto.

Change
concentration
units (in wizard)

Permite a los usuarios cambiar las unidades de concentración de los
parámetros de configuración avanzada en el asistente de cuantificación.

Create new
results tables

Permite a los usuarios crear una tabla de resultados nueva a través
del asistente de cuantificación o seleccionando la opción New del menú
File. El botón Guardar como seguirá estando disponible con esta opción.

Open existing
results tables

Permite a los usuarios abrir tablas de resultados.

When saving,
replace existing
results tables

Permite a los usuarios sobrescribir las tablas de resultados existentes.

Edit results
tables’ method

Permite a los usuarios modificar el archivo de métodos de cuantificación.
En modo Quantitate, haga clic en Tools > Results Table > Modify
Method. De esta forma, se modificará el archivo real y no el método
integrado en una tabla de resultados.

Create new
“standard”
queries (from
wizard)

Permite a los usuarios crear una consulta estándar nueva a través del
asistente de cuantificación.
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Tabla 5-11: Acceso a la cuantificación mediante el software Analyst MD (continuación)

Acceso
predefinido

Descripción

Exclude
standards from
calibration

Permite a los usuarios excluir patrones de la calibración en el panel
Calibration Curve, la tabla de resultados y el panel Statistics.

Add and
Remove
samples from
results table

Permite a los usuarios agregar o quitar muestras. (En el modo
Quantitate, haga clic en Tools > Results Table > Add/Remove
samples).

Deshabilite el acceso a este permiso para todos los usuarios, excepto
para los administradores.

Display metric
plots

Permite a los usuarios mostrar los gráficos de métricas de una tabla de
resultados. (En una tabla de resultados, haga clic con el botón derecho
y, a continuación, haga clic en Metric Plot).

Create or
modify formula
columns

Permite a los usuarios crear o modificar columnas de fórmula en una
tabla de resultados.

Modify sample
name

Permite a los usuarios modificar nombres de muestras.

Export results
table as text file

Permite a los usuarios exportar una tabla de resultados como archivo de
texto. (En el modo Quantitate, con una tabla de resultados abierta, haga
clic en Tools > Results Table > Export as Text).

Export settings
from results
table

Permite a los usuarios exportar la configuración de tabla a la
configuración de una tabla de resultados nueva. (Haga clic con el botón
derecho en una tabla de resultados y, a continuación, haga clic en Table
Settings > Export To New Table Settings).

Modify custom
column title

Permite a los usuarios modificar el título de una columna personalizada.
Una columna de fórmula no es una columna personalizada.

Modify results
table settings

Permite a los usuarios modificar la configuración de una tabla de
resultados (haga clic con el botón derecho y, a continuación, haga clic
en Table Settings > Edit) o la configuración de tablas global (en el
modo Quantitate, haga clic en Tools > Settings > New Quantitation
Results Table Settings). No es necesario modificar este ajuste de
seguridad en configuraciones de tablas existentes.

Modify global
(default)
settings

Permite a los usuarios modificar la configuración de tablas global. (En el
modo Quantitate, haga clic en Tools > Settings > New Quantitation
Results Table Settings.)

Modify audit
trail settings

Permite a los usuarios editar la configuración de las pistas de auditoría.
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Tabla 5-11: Acceso a la cuantificación mediante el software Analyst MD (continuación)

Acceso
predefinido

Descripción

Disable, enable
and clear audit
trail

Configuración heredada2

Change results
table column
visibility

Permite a los usuarios seleccionar las columnas que desee incluir en
una tabla de resultados. (Para acceder al cuadro de diálogo Table
Settings, haga clic con el botón derecho en la tabla de resultados y,
a continuación, haga clic en Table Settings > Edit).

Change results
table column
precision

Permite a los usuarios modificar las columnas de cifras significativas,
notación científica o precisión de una tabla de resultados. (Para acceder
al cuadro de diálogo Table Settings, haga clic con el botón derecho en
la tabla de resultados y, a continuación, haga clic en Table Settings >
Edit.. Haga clic en Columns y a continuación haga clic en Edit).

Run temporary
queries

Permite a los usuarios realizar consultas.

Modify or save
queries

Permite a los usuarios modificar o guardar consultas nuevas. (Para
modificar consultas, pulse Ctrl y haga clic con el botón derecho en la
tabla de resultados, haga clic en Consulta y, a continuación, seleccione
una consulta existente). Permite a los usuarios modificar consultas en
una tabla de resultados. (En una tabla de resultados, haga clic con el
botón derecho del ratón y, a continuación, haga clic en Table Settings
> Edit > Queries.. Seleccione una consulta existente y, a continuación,
haga clic en Edit).

Run temporary
sorts

Permite a los usuarios ordenar las consultas.

Modify or save
sorts

Permite a los usuarios editar o guardar las ordenaciones realizadas.

Use metric plot
settings dialog

Permite a los usuarios utilizar el cuadro de diálogo Metric Plot Settings.
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Tabla 5-11: Acceso a la cuantificación mediante el software Analyst MD (continuación)

Acceso
predefinido

Descripción

Modify or
create metric
plot settings

Permite a los usuarios crear gráficos de métricas nuevos a partir de la
tabla de resultados. (En la tabla de resultados, haga clic con el botón
derecho y, a continuación, haga clic en Metric Plot > New).

Permite a los usuarios modificar el gráfico de métricas de una tabla de
resultados. (En una tabla de resultados, haga clic con el botón derecho
y, a continuación, haga clic en Table Settings > Edit > Metric Plot.
Seleccione un gráfico de métricas existente y, a continuación, haga clic
en Edit).

Este ajuste de seguridad no impide a los usuarios modificar los gráficos
de métricas existentes ejecutando un gráfico de métricas, haciendo clic
con el botón derecho en el gráfico y, a continuación, seleccionando Edit
Settings.

Create Analyte
Groups

Permite a los usuarios crear grupos de analitos a partir de una tabla de
resultados. (En una tabla de resultados, haga clic con el botón derecho
y, a continuación, haga clic en Analyte Group > New).

Modify Analyte
Groups

Permite a los usuarios modificar grupos de analitos. (En una tabla de
resultados, haga clic con el botón derecho y, a continuación, haga clic
en Table Settings > Edit > Analyte Groups. Haga clic en un grupo
existente y, a continuación, haga clic en Edit).

Change default
peak review
options

Permite a los usuarios cambiar la configuración de picos
predeterminada. (En el modo Quantitate, haga clic en Tools > Settings
> Quantitation Peak Review Settings).

Change
“simple”
parameters in
peak review

Permite a los usuarios cambiar parámetros sencillos de la revisión de
picos. Si hay un panel Peak Review abierto, los parámetros sencillos
son aquellos que se muestran al hacer clic una vez en el botón Show o
Hide Parameters.

Change
“advanced”
parameters in
peak review

Permite a los usuarios cambiar los parámetros avanzados de la
revisión de picos. Si el panel Peak Review está abierto, los parámetros
avanzados son aquellos que se muestran al hacer clic dos veces en el
botón Show o Hide Parameters.

Manually
integrate

Permite a los usuarios integrar manualmente picos a través del modo de
integración manual del panel Peak Review.

“Update”
method in peak
review

Permite a los usuarios actualizar y revertir un método tras haber
modificado el método de cuantificación de un pico específico en el panel
Peak Review.
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Tabla 5-11: Acceso a la cuantificación mediante el software Analyst MD (continuación)

Acceso
predefinido

Descripción

Add or modify
annotation

Permite a los usuarios añadir o modificar anotaciones de muestras en el
panel o la ventana Peak Review mediante la opción Sample Annotation
del menú contextual o añadiendo una columna Sample Annotation a la
tabla de resultados.

Change
regression
parameters

Permite a los usuarios cambiar la configuración de regresión de un panel
Calibration Curve.

Modify Sample
ID

Permite a los usuarios modificar el ID de muestra en una tabla de
resultados.

Modify Sample
Type

Permite a los usuarios modificar el tipo de muestra en una tabla de
resultados.

Modify Sample
Comment

Permite a los usuarios modificar el comentario de la muestra en una
tabla de resultados.

Modify Weight
To Volume ratio

Permite a los usuarios modificar la relación entre peso y volumen en una
tabla de resultados.

Modify Dilution
Factor

Permite a los usuarios modificar el factor de dilución en una tabla de
resultados.

Modify Analyte
Concentration

Permite a los usuarios modificar las concentraciones de analitos en una
tabla de resultados.

Modify Analyte
Units

Configuración heredada2

Modify IS
Concentration

Permite a los usuarios modificar las concentraciones de IS en una tabla
de resultados.

Modify IS Units Configuración heredada2

Modify
Processing
Algorithm

Permite a los usuarios cambiar el algoritmo de cuantificación. (En
el modo Quantitate, haga clic en Tools > Settings > Quantitation
Integration Algorithm).

Enable or
Disable percent
rule in Manual
Integration

Permite a los usuarios cambiar la integración manual (regla de
porcentaje). (En el modo Quantitate, haga clic en Tools > Settings >
Quantitation Peak Review Settings).
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Tabla 5-12: Analyst MD

Acceso
predefinido

Descripción

Create/modify
report
templates

Permite a los usuarios crear plantillas de informe nuevas y modificar las
existentes.

Open report
templates as
read-only

Permite a los usuarios abrir archivos rpt en formato de solo lectura.
(Haga clic en File > Open).

Print Permite a los usuarios imprimir en cualquier modo.

Select report
templates

Permite a los usuarios seleccionar plantillas de informe en el cuadro de
diálogo Print.

Tabla 5-13: Analyst MD

Acceso
predefinido

Descripción

Start Sample Permite a los usuarios ejecutar una muestra de la cola.

Abort Sample Permite a los usuarios anular una muestra de la cola.

Stop Sample Permite a los usuarios detener una muestra de la cola.

Stop Queue Permite a los usuarios detener la cola.

Pause Sample
Now2

Permite a los usuarios interrumpir la muestra inmediatamente.

Insert Pause
Before Selected
Sample(s)2

Permite a los usuarios insertar una pausa antes de la siguiente muestra.

Continue
Sample2

Permite a los usuarios continuar (reiniciar) la muestra actual.

Next Period2 Permite a los usuarios adquirir el siguiente periodo inmediatamente.

Extend Period2 Permite a los usuarios ampliar el periodo que se esté adquiriendo en ese
momento.

Next Sample2 Permite a los usuarios adquirir la siguiente muestra.

Advance Pump
Gradient

Configuración heredada2

Equilibrate Permite a los usuarios equilibrar el sistema.

Stand By Permite a los usuarios activar el modo en espera del espectrómetro de
masas.
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Tabla 5-13: Analyst MD (continuación)

Acceso
predefinido

Descripción

Ready Permite a los usuarios activar el modo de listo del espectrómetro de
masas.

Reacquire Permite a los usuarios volver a adquirir las muestras.

Insert Pause2 Permite a los usuarios insertar una pausa en la cola.

Delete Sample
or Batch

Permite a los usuarios eliminar una muestra o un lote de la cola.

Move Batch Permite a los usuarios cambiar el orden de un lote en la cola.

Tabla 5-14: Acceso al ajuste mediante el software Analyst MD

Acceso
predefinido

Descripción

Edit parameter
settings

Permite a los usuarios editar la configuración de parámetros. (En el
modo Tune y Calibrate, haga clic en Tools > Settings > Parameter
Settings).

Edit tuning
options

Permite a los usuarios crear, eliminar y actualizar tablas de referencia
para estándares de calibración y editar las caídas de compensación
desde la resolución de la unidad para la resolución baja y abierta.

Edit instrument
data

Permite a los usuarios editar las tablas de calibración y resolución del
espectrómetro de masas.

Manual tune Permite a los usuarios utilizar la función de ajuste manual en el modo de
ajuste y calibración.

Calibrate from
current
spectrum

Permite a los usuarios llevar a cabo la calibración utilizando el espectro
actual.

Instrument
optimization

Permite a los usuarios ejecutar la función de optimización del
instrumento en el modo de ajuste y calibración.

Compound
optimization

Permite a los usuarios ejecutar la función de optimización de un
compuesto.

Tuning
Instrument

Permite a los usuarios ajustar y calibrar el espectrómetro de masas.

Advanced
Resolution
Table
Modification

Permite a los usuarios configurar la resolución mediante el botón
Avanzado de la pestaña de resolución.
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Tabla 5-14: Acceso al ajuste mediante el software Analyst MD (continuación)

Acceso
predefinido

Descripción

Auto TOF Mass
Calibration

Configuración heredada2

Tabla 5-15: Derechos de acceso al software Analyst MD

Acceso
predefinido

Descripción

Security Config Permite a los usuarios configurar los parámetros relacionados con la
seguridad.

View Status Permite a los usuarios ver el estado de los espectrómetros de masas
remotos.

Nota: Al crear o utilizar columnas de fórmula, recomendamos que los usuarios validen las
fórmulas antes del uso.

Acceso al software MultiQuant MD
Acceso
predefinido

Descripción

Create session
file

Permite a los usuarios crear una tabla de resultados.

Create
quantitation
method

Permite a los usuarios crear métodos de cuantificación.

Modify
quantitation
method files

Permite a los usuarios modificar los métodos de cuantificación situados
en la carpeta Quantitation Methods en la carpeta Analyst Data.

Allow Export and
Create Report of
unlocked
Results Table

Permite a los usuarios exportar o crear informes de tablas de resultados
sin bloquear.

Create
automatic
method

Permite a los usuarios seleccionar la opción Automatic Method cuando
crean tablas de resultados.
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Acceso
predefinido

Descripción

Replace existing
Results Table
when saved

Permite a los usuarios actualizar tablas de resultados existentes, pero
no les permite crear una nueva utilizando un nombre de tabla de
resultados existente. Por ejemplo, si se crea una tabla de resultados
llamada RT1, entonces los usuarios pueden actualizarla, pero no
pueden crear una nueva tabla de resultados usando el nombre RT1.
Los usuarios no pueden nombrar una tabla de resultados sin nombre
utilizando un nombre de tabla de resultados que ya exista.

Change default
quantitation
method
integration
algorithm

El cuadro de diálogo Integration Default permite a los usuarios cambiar
el algoritmo. (Haga clic en Edit > Project Integration Defaults).

Change default
quantitation
method
integration
parameters

El cuadro de diálogo Integration Default permite a los usuarios cambiar
los parámetros predeterminados del algoritmo. (Haga clic en Edit >
Project Integration Defaults).

Allow Enable
Project Modified
Peak Warning

Permite a los usuarios activar o desactivar el indicador que habilita la
opción Project Modified Peak Warning del menú Edit.

Add samples to
Results Table

Permite a los usuarios agregar muestras. (Haga clic en Process > Add
Samples).

Remove
samples from
Results Table

Permite a los usuarios eliminar las muestras seleccionadas. (Haga clic
en Process > Remove Selected Samples).

Export, import,
or remove
External
Calibration

Permite a los usuarios exportar, importar o eliminar una calibración
externa utilizando una de las siguientes opciones:

• Haga clic en Process > Export Calibration.

• Haga clic en Process > Import External Calibration.

• Haga clic en Process > Remove External Calibration.

Use, edit, or
clear Isotopic
Correction

Permite a los usuarios utilizar, modificar o borrar una corrección
isotópica utilizando una de las opciones siguientes:

• Haga clic en Process > Use Default Isotope Correction.

• Haga clic en Process > Edit Current Isotope Correction.

• Haga clic en Process > Clear Previous Isotope Correction.
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Acceso
predefinido

Descripción

Change Audit
Map settings

Permite a los usuarios modificar el mapa de auditoría del proyecto y
modificar la definición del mapa de auditoría. (Haga clic en Audit Trail >
Audit Map Manager).

Modify Sample
Name

Permite a los usuarios modificar el nombre de la muestra en la Results
Table.

Modify Sample
Type

Permite a los usuarios cambiar el tipo de muestra (patrón, CC,
desconocida) en la tabla de resultados.

Modify Sample
ID

Permite a los usuarios modificar el ID de la muestra en la Results Table.

Modify Actual
Concentration

Permite a los usuarios modificar la concentración del patrón y el CC en
la tabla de resultados.

Modify Dilution
Factor

Permite a los usuarios modificar el factor de dilución en la tabla de
resultados.

Modify Comment
Fields

Permite a los usuarios modificar los campos de comentarios:

• Component Comment

• IS Comment

• IS Peak Comment

• Peak Comment

• Sample Comments

Allow manual
integration

Permite a los usuarios activar el modo de integración manual en el panel
Peak Review.

Allow set to
Peak Not Found

Permite a los usuarios utilizar la funcionalidad Set peak to not found en
Peak Review. Para realizar esta acción, haga clic con el botón derecho
en el panel Peak Review.

Include or
exclude a peak
from the Results
Table

Permite a los usuarios incluir o excluir picos de las tablas de resultados,
las tablas de estadísticas y las curvas de calibración.

Modify
regression
settings for fit
and weight

Permite al usuario modificar la configuración de regresión en el panel
Calibration Curve cuando usa la funcionalidad Modify Results Table
Method y cuando usa el asistente New Quantitation Method.
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Acceso
predefinido

Descripción

Modify Results
Table integration
parameters for a
single
chromatogram

Permite al usuario modificar un único cromatograma.

Modify
quantitation
method for the
Results Table
component

Permite al usuario aplicar las modificaciones de los cromatogramas
únicos al componente.

Los usuarios tienen que tener habilitado este permiso y el de Modify
Results Table integration parameters for a single chromatogram si
quieren actualizar y después aplicar las modificaciones individuales a
los componentes.

Create, use, or
export Metric
Plots in Results
Tables

Permite a los usuarios crear y usar gráficos de métricas en la tabla de
resultados (el botón Metric Plot está habilitado) o exportar gráficos de
métricas. (Haga clic en File > Export).

Set Peak
Review Title
Format

Permite a los usuarios modificar el formato del título de revisión de picos
en el panel Peak Review. Para realizar esta acción, haga clic con el
botón derecho en el panel Peak Review.

Add, Rename, or
Modify custom
column

Permite a los usuarios añadir, renombrar o modificar una columna
personalizada. Incluso sin este permiso, los usuarios pueden ejecutar
consultas que crearán automáticamente columnas personalizadas.

Remove custom
column

Permite a los usuarios eliminar una columna personalizada de la tabla
de resultados.

Modify Results
Table column
settings

Permite a los usuarios modificar la configuración de columnas en una
tabla de resultados.

Save Column
Settings as
Project Default

Permite a los usuarios aplicar la configuración de la columna al proyecto.

Lock and save
Results Table

Permite a los usuarios bloquear y guardar una tabla de resultados.

Unlock and save
Results Table

Permite a los usuarios desbloquear y guardar una tabla de resultados.

Review and
save Results
Table

Permite a los usuarios revisar y guardar la tabla de resultados.
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Acceso
predefinido

Descripción

Create or edit
queries in
Results Tables

Permite a los usuarios crear o editar consultas en una tabla de
resultados utilizando una de las opciones siguientes:

• Haga clic en Process > Create Simple Query.

• Haga clic en Process > Edit Simple Query.

Use Results
Table queries

Permite a los usuarios realizar consultas. (Haga clic en Process >
Query).

Use unencrypted
MultiQuant
queries

Permite a los usuarios ejecutar consultas .xls desde la carpeta
configuración de MQ.

Nota: Si se desinstala el software MultiQuant MD, los elementos de seguridad del software
MultiQuant MD permanecen en el software Analyst MD. Los elementos de seguridad se
encuentran en la pestaña Roles del cuadro de diálogo Security Configuration.

Añadir un usuario o grupo al software Analyst MD
Nota: Los cambios realizados en la configuración de seguridad del software Analyst MD
tendrán efecto tras reiniciar el software Analyst MD.

1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.
Se abre el cuadro de diálogo Security Configuration.

2. Abra la pestaña People.

3. Haga clic en New Person.
Se abre el cuadro de diálogo Select Users or Groups.

4. Añada un usuario o grupo.

5. En el panel Available Roles, haga clic en una función y, a continuación, en Add.

6. Haga clic en Apply.

7. Haga clic en OK.
Se cierra el cuadro de diálogo Select Users or Groups.

8. Haga clic en OK.
Se cierra el cuadro de diálogo Security Configuration.

Cambio de funciones
1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.

Se abre el cuadro de diálogo Security Configuration.

2. Abra la pestaña People.
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3. En el panel izquierdo, haga clic en el usuario que corresponda y, a continuación, realice
una de las siguientes acciones:

• En el panel Available Roles, haga clic en la función necesaria y, a continuación, en
Add para agregar una función.

• En el panel Role(s) Selected, haga clic en la función necesaria y, a continuación, en
Remove para quitar una función.

4. Haga clic en Apply.

5. Haga clic en OK.
Se cierra el cuadro de diálogo Security Configuration.

Eliminar usuarios del software Analyst MD
1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.

Se abre el cuadro de diálogo Security Configuration.

2. Abra la pestaña People.

3. En el panel izquierdo, haga clic en el usuario que desee eliminar y, a continuación, haga
clic en Delete.

4. Haga clic en Apply.

5. Haga clic en OK.
Se cierra el cuadro de diálogo Security Configuration.

Crear una función personalizada
1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.

Se abre el cuadro de diálogo Security Configuration.

2. Haga clic en More y luego abra la pestaña Roles.
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Figura 5-6: Cuadro de diálogo de configuración de seguridad: Pestaña de
funciones

3. Haga clic en New Role.
Se abre el cuadro de diálogo New Role.

4. Escriba el nombre de la función y la descripción en los campos Role Name y
Description, respectivamente.

5. Haga clic en OK.

Nota: Todas las funciones definidas por el usuario disponen de acceso completo al
software Analyst MD. En el panel Access to Analyst, una marca de verificación verde
indica que está habilitado el acceso al sistema. Una X roja significa que no se puede
acceder al sistema.

6. Haga doble clic en los componentes de la lista Access to Analyst para habilitar o
deshabilitar el acceso.

7. Para configurar el acceso en un nivel funcional, expanda los componentes y, a
continuación, haga doble clic en la funcionalidad para habilitarla o deshabilitarla.

8. Haga clic en Apply.

9. Haga clic en OK.
Se cierra el cuadro de diálogo Security Configuration.

Eliminar una función personalizada
Nota: Si un usuario tiene asignada una única función y va a eliminar esa función, el sistema
le solicitará que elimine tanto el usuario como la función.

1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.
Se abre el cuadro de diálogo Security Configuration.
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2. Haga clic en More y luego abra la pestaña Roles.
Se abre el panel Roles.

3. Seleccione la función y, a continuación, haga clic en Delete.

4. Haga clic en Apply.

5. Haga clic en OK.
Se cierra el cuadro de diálogo Security Configuration.

Establecer el acceso
Un administrador puede configurar el acceso a los proyectos y archivos de proyectos por
usuario o grupo y controlar dicho acceso mediante la asignación de usuarios o grupos de
seguridad de Windows.

Para utilizar esta función de seguridad del software Analyst MD, utilice NTFS para la ruta
de trabajo. Si el administrador no configura los parámetros de seguridad del proyecto, el
acceso del operador a los archivos del proyecto dependerá de la configuración de datos
de cada usuario de Windows en NTFS. Para obtener más información, consulte la sección
Configuración del sistema de seguridad de Windows.

Nota: Si se crea un proyecto a través del software Analyst MD, todos los usuarios tendrán
acceso a las carpetas y subcarpetas del proyecto.

1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.

Figura 5-7: Cuadro de diálogo Security Configuration: pestaña Projects

2. En el panel izquierdo, haga clic en una carpeta o archivo.
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3. Haga clic en View/Edit Access Rights.
Se abrirá el cuadro de diálogo Properties.

4. Añada o elimine usuarios o grupos, defina los permisos necesarios y, a continuación,
haga clic en OK.

5. Haga clic en Apply.

6. Haga clic en OK.
Se cierra el cuadro de diálogo Select Users or Groups.

7. Haga clic en OK.
Se cierra el cuadro de diálogo Security Configuration.

Carpetas de un proyecto
Cada proyecto contiene carpetas en las que se guardan diferentes tipos de archivos. Para
obtener más información sobre el contenido de las distintas carpetas, consulte la Tabla 5-16.

Tabla 5-16: Carpetas de un proyecto

Carpeta Contenido

\Acquisition Methods Contiene todos los métodos de adquisición utilizados. Los
métodos de adquisición tienen la extensión dam.

\Acquisition Scripts No hay scripts de adquisición disponibles en el software
Analyst MD. Esta carpeta está vacía. El uso de la función
de creación de scripts del software Analyst MD, que
permite la creación de scripts personalizados (secuencias
de funcionamiento de Analyst personalizadas), no se debe
utilizar como parte de un dispositivo de diagnóstico in
vitro. Las comprobaciones vinculadas al software que se
llevan a cabo cuando se utiliza el software Analyst MD no
se ejecutan en scripts personalizados y pueden conllevar
riesgos.

\Batch Contiene todos los archivos de lotes de adquisición que se
han guardado. Los lotes de adquisición tienen la extensión
dab. Esta carpeta también contiene una subcarpeta
denominada Templates, que contiene las plantillas de
los lotes de adquisición. Las plantillas de lotes tienen la
extensión dat.

\Data Contiene los archivos de datos de adquisición. Estos
archivos tienen la extensión wiff.

\Log Contiene los resultados de cuantificación y optimización de
compuestos.

\Processing Methods Contiene todos los métodos de procesamiento de datos
cualitativos utilizados.
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Tabla 5-16: Carpetas de un proyecto (continuación)

Carpeta Contenido
\Processing Scripts Contiene dos scripts de procesamiento de datos. Los

scripts de procesamiento almacenados en el proyecto API
Instrument están disponibles en el menú Scripts.

\Project Information Contiene toda la información y configuraciones del proyecto.
Esta carpeta no se puede almacenar en un subproyecto.

\Quantitation Methods Contiene todos los métodos de cuantificación utilizados. Los
métodos de cuantificación tienen la extensión qmf.

\Results Contiene todos los archivos de tablas de resultados de
cuantificación (extensión rdb).

\Templates Contiene plantillas de informe (extensión rpt).

Tipos de archivo del software
Para los tipos de archivo comunes del software Analyst MD, consulte la Tabla 5-17.
La carpeta API Instrumentcontiene todos los subdirectorios, excepto Processing
Methods y Results.

Tabla 5-17: Archivos del software Analyst MD

Extensión Tipo de archivo Carpeta

ata Archivos de pistas de auditoría Project Information
atd • Datos de pistas de auditoría de

instrumentos

• Configuración de pistas de
auditoría de instrumentos

• Datos de pistas de auditoría de
proyectos

• Configuración de pistas de
auditoría de proyectos

Project Information

cam Mapa de auditoría Project Information
dab Lote de adquisición Batch
dam Método de adquisición Acquisition Methods
dat Plantilla de lote de adquisición Batch\Templates
dll Biblioteca de enlaces dinámicos Processing Scripts
eph Datos del historial de

procesamiento de exploración
Processing Methods
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Tabla 5-17: Archivos del software Analyst MD (continuación)

Extensión Tipo de archivo Carpeta

hwpf Perfil de hardware Configuration3

ins Información de calibración de datos
del instrumento

Instrument Data3

log Archivo de registro de recopilación
automática

Log

mdb Base de datos de MS Access —

pdf Formato de documento portátil —

psf Parámetros de configuración Parameter Settings3

qmf Método de cuantificación Quantitation Methods
rdb Tabla de resultados. (contiene

datos de pistas de auditoría de
cuantificación)

Results

rpt Plantilla de informes • Templates\Batch
• Templates\Method
• Templates\ Report
• Templates\Workspace

rtf Formato de texto enriquecido —

sdb Configuración de pistas de
auditoría de cuantificación

Project Information

tun Archivo de preferencias de ajuste Preferences3

txt Texto —

wiff.scan Archivo de datos de espectrometría
de masas

• Tuning Cache3

• Data

xls o xlsx Hoja de cálculo Excel Batch

En el proyecto Example, se admiten los siguientes formatos para la importación de
información de lotes:

• mdb

• txt

• xls o xlsx

3 Solo existe en la carpeta API Instrument. El resto de las subcarpetas se encuentran dentro de cada
carpeta del proyecto. Pueden estar en la carpeta del proyecto en sí o dentro de cada subproyecto.
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Configuración del Firewall de Windows en ordenadores de
adquisición y cliente
Para gestionar de forma remota un espectrómetro de masas con el software Analyst MD
en un ordenador cliente, el firewall de Windows debe estar configurado tanto en el
ordenador de adquisición como en el cliente. El firewall de Windows del ordenador de
adquisición debe estar configurado para permitir la ejecución tanto de Analyst.exe como de
AnalystService.exe. En el ordenador cliente, el firewall de Windows debe estar configurado
para permitir la ejecución de Analyst.exe.

Nota: Tanto el ordenador de adquisición, al que se tendrá acceso remoto, como el
ordenador cliente, desde el que se accederá al ordenador de adquisición, deben encontrarse
en el mismo dominio de red.

Nota: En el ordenador de adquisición, asegúrese de mantener la página de cola abierta
después de enviar un lote para que el ordenador cliente la pueda ver de forma remota.

Configurar el Firewall de Windows en el ordenador de adquisición
El ordenador de adquisición debe estar configurado para admitir Analyst.exe y
AnalystService.exe a través del firewall de Windows.

1. Abra el Control Panel y luego el firewall de Windows.

Figura 5-8: Panel de control

2. Haga clic en Allow an app or feature through Windows Firewall en el panel
izquierdo.

3. Haga clic en Change Settings.

4. Haga clic en Allow another app.
Se abre el cuadro de diálogo Add an app.
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5. Haga clic en Browse y luego vaya a la carpeta C:\Program
Files(x86)\Analyst\bin.

6. Haga clic en AnalystService.exe y, a continuación, en Open.

7. Haga clic en Add.
AnalystService se añade a la lista Allowed apps and features.

8. Si AB SCIEX Analyst no aparece en la lista Allowed apps and features, añada
Analyst.exe repitiendo los pasos a 37. No obstante, en lugar de seleccionar
AnalystService.exe, seleccione Analyst.exe en el paso 6.

9. Haga clic en OK.

Configuración del firewall de Windows en el ordenador cliente
Si Analyst.exe no está en la lista Allowed apps and features para el firewall de Windows en
el ordenador cliente, añádalo.

1. Abra el Control Panel y luego el firewall de Windows.

Figura 5-9: Panel de control

2. Haga clic en Allow an app or feature through Windows Firewall en el panel
izquierdo.

3. Haga clic en Change Settings.

4. Haga clic en Allow another app.
Se abre el cuadro de diálogo Add an app.

5. Haga clic en Browse y luego vaya a la carpeta C:\Program
Files(x86)\Analyst\bin.

6. Haga clic en Analyst.exe y, a continuación, en Open.

7. Haga clic en Add.
AB SCIEX Analyst se añade a la lista Allowed apps and features.

8. Haga clic en OK.
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Estaciones de trabajo remotas
Es posible configurar una lista de espectrómetros de masas en un ordenador local y
supervisar las colas de muestras de esos espectrómetros de masas de forma remota. Los
usuarios solo pueden ver la cola de muestras y el estado de los espectrómetros de masas
en estas estaciones de trabajo remotas. Aunque puedan llevar a cabo otras acciones en la
estación de trabajo local, no podrán realizarlas en una estación de trabajo remota.

Nota: Tanto el ordenador de adquisición, al que se accede de forma remota, como el
ordenador local, desde el que se accede al ordenador de adquisición, deben encontrarse en
el mismo dominio de red.

Añadir acceso a una estación de trabajo
1. Inicie sesión en el software Analyst MD como usuario basado en dominio

(usuario@dominio).

2. En la barra Navigation, en Configure, haga doble clic en Security Configuration.
Se abre el cuadro de diálogo Security Configuration.

3. Abra la pestaña Remote Viewers y luego haga clic en Add.

Figura 5-10: Cuadro de diálogo de nuevo instrumento

4. Escriba el nombre de la estación de trabajo en el campo Name.
Si se utiliza Active Directory en el entorno nativo, el campo de dominio no es visible y se
puede introducir un nombre de usuario en formato UPN.

5. Si es necesario, escriba la información de ubicación en el campo Location.

6. Haga clic en Browse para buscar un Domain y un Computer.
Se abrirá el cuadro de diálogo Select Computers.

7. Seleccione un espectrómetro de masas haciendo clic en Object Types.
Se abre el cuadro de diálogo Windows Security.

8. Escriba las credenciales del dominio y haga clic en OK.
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Se muestra el cuadro de diálogo Select Computers.

9. Haga clic en Locations.
Se abre el cuadro de diálogo Locations.

10. Haga clic en la red en la que se encuentre el ordenador de adquisición remoto y
después haga clic en OK.
Se muestra el cuadro de diálogo Select Computers.

11. Escriba el nombre del ordenador de adquisición en el cuadro Enter the object names
to select.

12. Haga clic en Check Names.

13. Haga clic en OK.

14. Si fuera necesario, escriba una descripción en el campo Description del cuadro de
diálogo New Instrument.

15. Haga clic en OK.
El nombre del ordenador de adquisición y el nombre del dominio se muestra en la
pestaña Remote Viewers.

16. Haga clic en Apply.

17. Haga clic en OK.
Se cierra el cuadro de diálogo Security Configuration.

18. Inicie nuevamente el software Analyst MD.

Ver el estado del instrumento remoto y la cola de adquisición de
muestras
Para ver el instrumento, el estado de los dispositivos conectados y la cola de adquisición
de muestras en el ordenador de adquisición de forma remota, utilice el icono Status for
Remote Instrument en el software Analyst MD del ordenador del cliente.
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Figura 5-11: Icono de estado del instrumento remoto en el software Analyst MD

1. Inicie sesión en el software Analyst MD con el mismo usuario basado en dominio que se
usó para añadir el instrumento remoto en el cuadro de diálogo Security Configuration en
Añadir acceso a una estación de trabajo.

2. En el software Analyst MD del ordenador cliente, con el modo Acquire seleccionado,
haga clic en el icono Status for Remote Instrument.

3. En el cuadro de diálogo Remote Instrument Station, seleccione el instrumento en el
cuadro Select the Instrument Station y, a continuación, haga clic en Connect.

Figura 5-12: Estación de instrumento remoto y dispositivo integrado mostrados
en el software Analyst MD

4. Haga doble clic en el icono de instrumento remoto para ver el estado detallado.
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Figura 5-13: Estado detallado del instrumento remoto

5. Haga doble clic en el icono de jeringa integrada para ver el estado detallado.

Figura 5-14: Estado detallado de la jeringa integrada

6. Para ver la cola de adquisición de muestras en el ordenador de adquisición, en el modo
Acquire, haga clic en el icono de Instrument Queue en la barra de herramientas del
software Analyst MD.
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Nota: La página de la cola debe estar abierta en el ordenador de adquisición para que
la cola se pueda ver de forma remota desde el ordenador cliente.

7. En el cuadro de diálogo Remote Instrument Station, seleccione el instrumento en el
cuadro Select the Instrument Station y haga clic en Connect.
La cola de adquisición de muestras del ordenador de adquisición se muestra en el
software Analyst MD.

Figura 5-15: Cola de adquisición de muestras en el ordenador de adquisición

Retirar acceso a una estación de trabajo
1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.

2. En el cuadro de diálogo Security Configuration, abra la pestaña Remote Viewers.

3. En el panel izquierdo, seleccione un ordenador.

4. Haga clic en Delete.

5. Haga clic en Yes para confirmar.

6. Haga clic en OK para cerrar el cuadro de diálogo Security Configuration.

7. Vuelva a iniciar el software Analyst MD.

Imprimir la configuración de seguridad
Imprima una copia de la configuración de seguridad para tenerla archivada.

1. En la barra Navigation, en Configure, haga doble clic en Security Configuration.
Se abre el cuadro de diálogo Security Configuration.

2. Haga clic en Print.

3. Haga clic en Apply.

4. Haga clic en OK.
Se cierra el cuadro de diálogo Security Configuration.
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Monitorización del estado del
sistema 6
Trazos auxiliares
Los trazos auxiliares de un sistema de LC, como el trazo de presión de la bomba y el trazo
de temperatura del horno de columna, se pueden almacenar en el archivo de datos para
cada muestra. Esos trazos se pueden utilizar para supervisar el estado de un sistema de
LC. Los trazos, especialmente el trazo de presión de la bomba, también pueden ayudar a
resolver los problemas relacionados con LC.

La función de trazos auxiliares solo es compatible con el software Analyst MD, versión 1.7.3
y posteriores.

Habilitar trazos auxiliares
Para activar la función de trazos auxiliares, siga estos pasos cuando configure el dispositivo
de LC en el perfil de hardware.

1. En el cuadro de diálogo Create New Hardware Profile o Edit Hardware Profile,
seleccione el sistema de LC y, a continuación, haga clic en Setup Device.

2. Seleccione la casilla Enable Aux Trace Monitoring.

3. Asegúrese de que la configuración del sistema de LC se haya completado y, a
continuación, haga clic en OK.

4. Active el perfil de hardware.

5. Adquirir datos.

Mostrar trazos auxiliares
1. Asegúrese de que la carpeta de proyecto correcta esté seleccionada.

2. En la barra Navigation, en Explore, haga doble clic en Open Data File.
Se abrirá el cuadro de diálogo Select Sample.

3. En el campo Data Files, haga clic en el archivo de datos que se haya adquirido después
de activar la supervisión de trazos auxiliares.

4. En la lista Samples, seleccione una muestra y, a continuación, haga clic en OK.

5. Haga clic en Explore > Show > Show Auxiliary Traces.
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Figura 6-1: Cuadro de diálogo Select Auxiliary Trace Channel

6. En la lista Channel, seleccione un canal y, a continuación, haga clic en OK.
El trazo auxiliar seleccionado se muestra en un nuevo panel debajo del panel activo.

Contador de inyecciones
Con el contador de inyecciones, el usuario puede supervisar el número de inyecciones de
muestras en una columna analítica determinada en un solo sistema de LC-MS/MS. Esta
función ayuda al usuario a saber cuándo se debe cambiar de columna a fin de impedir que el
lote se vuelva a ejecutar.

Activar el contador de inyecciones
1. Asegúrese de que el sistema esté en estado de espera.

2. En el modo Configure, haga clic en Tools > Settings > Injection Counter Options.

3. Seleccione la casilla Enable Injection Counter.

4. Complete una fila para cada columna analítica en la que se contarán las inyecciones.
Cada fila contiene los campos de la siguiente tabla.

Tabla 6-1: Cuadros de diálogo Injection Counter

Campo Descripción

Active Seleccione esta opción para activar el recuento de inyecciones para
esta columna analítica. Cuando se selecciona esta opción, el número
de las inyecciones en esta columna analítica se incrementa en uno
por cada inyección. Si se utiliza la conmutación de columnas, varias
columnas de análisis pueden estar activas al mismo tiempo.

Column
Description

Escriba la información para identificar la columna en los informes y
visualizaciones. Incluya información como la marca, el tipo, el tamaño
de las partículas, el diámetro y la longitud de la columna.

Column S/N Escriba el número de serie de la columna analítica.
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Tabla 6-1: Cuadros de diálogo Injection Counter (continuación)

Campo Descripción

Number of
injections

Al configurar los ajustes del contador de inyecciones, escriba el número
de inyecciones que ya se han realizado en la columna analítica.
Si la función de contador de inyecciones está activada, el software
incrementa automáticamente este campo durante el funcionamiento de
un sistema LC que tenga un procesador de muestras automático.

Threshold Escriba el número de inyecciones que activarán una advertencia.
Cuando el usuario envía un lote que hará que el número de
inyecciones supere este umbral, aparece una advertencia. El usuario
puede entonces optar por continuar o cancelar el lote y utilizar otra
columna analítica. Diferentes columnas analíticas activas pueden tener
diferentes umbrales.
Nota: Asegúrese de actualizar la configuración del contador de
inyecciones después de instalar una columna diferente.

5. Para añadir columnas analíticas, haga clic en + y luego repita el paso 4.

Nota: Para eliminar una columna analítica de la lista, haga clic en el signo menos (-) a la
derecha de la columna.

6. Haga clic en OK.
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Auditoría 7
En esta sección se explica cómo utilizar la función de auditoría del software. Para obtener
información acerca de las funciones de auditoría de Windows, consulte la sección Auditorías
del sistema.

Pistas de auditoría
El software Analyst MD agrupa los eventos auditados por espectrómetro de masas, proyecto
y cuantificación en pistas de auditoría, que son archivos que contienen registros de dichos
eventos auditados. Las pistas de auditoría, combinadas con archivos como los archivos wiff
y de tablas de resultados, conforman registros electrónicos válidos que se pueden utilizar
con fines de cumplimiento normativo.

Tabla 7-1: Pistas de auditoría del software Analyst MDPistas de auditoría de

Pista de auditoría Ejemplos de
eventos registrados

Mapas de auditoría
disponibles
almacenados en

Mapas de auditoría
predeterminados

Instrumento (uno por
estación de trabajo)

• Cambios en:

• Resoluciones
de
instrumentos

• Calibraciones
de masas

• Colas de
muestras

• Seguridad

• Perfiles de
hardware

• Entradas del
registro de
mantenimiento de
instrumentos

• Proyecto API
Instrument

• Carpeta Project
Information

• En una instalación
nueva, mapa
de auditoría
predeterminado
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Tabla 7-1: Pistas de auditoría del software Analyst MDPistas de auditoría de
(continuación)

Pista de auditoría Ejemplos de
eventos registrados

Mapas de auditoría
disponibles
almacenados en

Mapas de auditoría
predeterminados

Proyecto (uno por
proyecto)

• Cambios en:

• Proyecto

• Método

• Cuantificación

• Batch

• Datos

• Tabla de
resultados

• Ajustes

• Archivos de
plantillas de
informe

• Apertura y cierre
de módulos

• Impresión

• Cada proyecto

• Carpeta Project
Information

• Copiados
del proyecto
predeterminado

Cuantificación (una
por tabla de
resultados)

Cambios en:

• Métodos de
cuantificación

• Información de
muestras

• Parámetros de
integración de
picos

• Archivo de tabla
de resultados
(archivo rdb)

• Copiados del
proyecto primario

Cuando la pista de auditoría de un instrumento o un proyecto contiene 1000 registros de
auditoría, el software Analyst MD archiva automáticamente los registros y comienza una
nueva pista de auditoría. Para obtener más información, consulte la sección Registros de
pistas de auditoría.

Mapas de auditoría
Los mapas de auditoría son archivos que especifican:

• Los eventos que se han auditado.
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• Los eventos auditados para los que el operador debe especificar los motivos del cambio
realizado.

• Los eventos auditados que requieren firmas electrónicas.

Se pueden crear muchos mapas de auditoría para el espectrómetro de masas y los
proyectos, pero solo se puede usar uno cada vez para cada ordenador de adquisición y
cada proyecto. El mapa de auditoría utilizado es el denominado mapa de auditoría activo de
ese espectrómetro de masas o proyecto.

Cada mapa de auditoría contiene una lista de todos los eventos que se pueden auditar.
En función del lugar en el que se utilice el mapa, los eventos se aplicarán a la pista de
auditoría del instrumento o a las pistas de auditoría del proyecto y de cuantificación. Para
cada evento, especifique si está auditado, si se requiere una firma electrónica y hasta diez
razones predefinidas para el evento.

Cuando el usuario crea un nuevo proyecto, los mapas de auditoría para el proyecto se
copian del proyecto Default. El mapa de auditoría activo del proyecto predeterminado se
convierte en el mapa de auditoría activo del nuevo proyecto.

Cuando el usuario crea una tabla de resultados nueva, la configuración de las pistas de
auditoría de cuantificación se define a través de los eventos de cuantificación del mapa
de auditoría activo del proyecto. Al guardar una tabla de resultados, la configuración de
auditoría del mapa de auditoría activo se almacena permanentemente junto con la tabla de
resultados. Si se modifica el mapa de auditoría activo (aplicado al proyecto), la configuración
de auditoría original permanece integrada en el archivo de la tabla de resultados. Para
diferenciar la configuración integrada del mapa de auditoría modificado, consulte la fecha y
hora de la última modificación, mostradas en la pestaña Settings.

Configuración de mapas de auditoría
Antes de comenzar a trabajar con proyectos para los que sea necesario realizar auditorías,
debe configurar mapas de auditoría apropiados para los procedimientos de funcionamiento
estándar. Existen varios mapas de auditoría cuando se instala el software Analyst MD, pero
uno o varios de ellos se pueden personalizar. Como mínimo, debe asegurarse de que haya
disponible un mapa de auditoría adecuado para la pista de auditoría del instrumento y un
mapa de auditoría apropiado para cada proyecto.

Tabla 7-2: Lista de comprobación para configurar la auditoría

Tarea Consulte

Crear un mapa de auditoría para la pista de
auditoría del instrumento.

• Crear un mapa de auditoría.

• Modificación de un mapa de auditoría.

Aplicar el mapa de auditoría a la pista de
auditoría del instrumento.

• Aplicación de un mapa de auditoría.

Crear un mapa de auditoría activo
predeterminado para los proyectos nuevos.

• Crear un mapa de auditoría.

• Modificación de un mapa de auditoría.
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Tabla 7-2: Lista de comprobación para configurar la auditoría (continuación)

Tarea Consulte

Especificar el mapa de auditoría activo
predeterminado para los proyectos nuevos.

• Aplicación de un mapa de auditoría.

Configurar el mapa de auditoría para usarlo
en cada proyecto existente.

• Crear un mapa de auditoría.

• Modificación de un mapa de auditoría.

• Copiar un mapa de auditoría de otro
proyecto.

Aplicar un mapa de auditoría a cada
proyecto existente.

• Aplicación de un mapa de auditoría.

Mapas de auditoría instalados
El software incluye distintos mapas de auditoría. Para ver o modificar un mapa de auditoría
instalado, consulte la sección Modificación de un mapa de auditoría.

Tabla 7-3: Mapas de auditoría instalados

Mapa de
auditoría

Descripción

Mapa de
auditoría
predeterminado

Tras la instalación, el mapa de auditoría predeterminado es el
mapa de auditoría activo de cualquier proyecto nuevo. De manera
predeterminada, todos los eventos se auditan de forma silenciosa en el
software Analyst MD. Si los ajustes de pista de auditoría de un proyecto
de una versión anterior del software Analyst MD se han convertido,
el mapa de auditoría predeterminado contiene esa configuración de
auditoría.

Mapa de
auditoría
completo

Se auditan todos los eventos. Se requieren firmas electrónicas y motivos
para todos los eventos.

No hay mapa de
auditoría

No se audita ningún evento.

Mapa de
auditoría solo de
eventos de
cuantificación

Solo se auditan los eventos de cuantificación. Estos eventos requieren
una firma electrónica y un motivo.

Mapa de
auditoría
silencioso

Se auditan todos los eventos. No se requieren firmas electrónicas ni
motivos para ningún evento.
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Para obtener una descripción de los tipos de pistas de auditoría y su relación con los mapas
de auditoría, consulte la Tabla 7-1. Para obtener más información acerca de los eventos
registrados en las pistas de auditoría, consulte la sección Registros de pistas de auditoría.

Para conocer la ubicación de los mapas de auditoría y las pistas de auditoría en el gestor de
pistas de auditoría, consulte la Figura 7-1.

Figura 7-1: Gestor de pistas de auditoría: Ubicación de los mapas de auditoría y las
pistas de auditoría

Para obtener información acerca del proceso de auditoría, consulte la Tabla 7-2.

Trabajo con mapas de auditoría
El software Analyst MD tiene diversos mapas de auditoría instalados. Revíselos para
determinar si modificar uno o varios de ellos es más sencillo que crear uno nuevo. Para
obtener una descripción de los mapas de auditoría, consulte la sección Mapas de auditoría
instalados. Para obtener una lista de comprobación de los pasos recomendados para
configurar las auditorías, consulte la sección Configuración de mapas de auditoría.

Si se elimina un mapa de auditoría activo en el software Analyst MD o en el explorador
de archivos, el proyecto que utilice ese mapa de auditoría utilizará el mapa de auditoría
predeterminado (Default Audit Map.cam). El mapa de auditoría predeterminado no se
puede borrar.

Crear un mapa de auditoría
El mapa de auditoría activo del proyecto determina qué eventos se registran en la pista de
auditoría del proyecto y en las pistas de auditoría de cuantificación de todas las tablas de
resultados creadas.

1. Haga clic en View > Audit Trail Manager.
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Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data.

3. Expanda la carpeta Projects.

4. En la sección Projects, haga clic en el proyecto para el que se va a crear un mapa de
auditoría. Para crear un mapa de auditoría con el fin de usarlo con la pista de auditoría
del instrumento, haga clic en la carpeta API Instrument.

Sugerencia: Para crear un mapa de auditoría con el fin de usarlo con la pista de
auditoría del instrumento, haga clic en Instrument encima de la carpeta Projects.

5. En la pestaña Settings, haga clic en Edit.
Se abrirá el cuadro de diálogo Audit Map Editor con el mapa de auditoría activo visible.

Figura 7-2: Cuadro de diálogo Audit Map Editor

6. Haga clic en New.
Se muestra un mapa de auditoría nuevo sin eventos auditados.

7. Si es necesario, en el campo Selected Audit Map Description, escriba una descripción
del mapa de auditoría.

8. En la tabla Audit Map, configure cada evento de la forma siguiente:

• Para auditar el evento, seleccione la casilla de verificación de la columna Audited.

Sugerencia: Para rellenar celdas consecutivas de una columna con el mismo texto
o valor de casilla, escriba el texto en la primera fila y, a continuación, seleccione las
filas de la columna comenzando por la primera fila. En las filas seleccionadas, haga
clic con el botón derecho y, a continuación, haga clic en Fill Down.
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• Para obligar a los usuarios a que especifiquen un motivo predefinido para cada
cambio cuando se produzca el evento en cuestión, active la casilla de verificación de
la columna Reason Prompt y, a continuación, en la columna Predefined Reason,
especifique hasta diez motivos.

• Para obligar a los usuarios a que escriban un motivo personalizado, active la casilla
de verificación de la columna Reason Prompt y, a continuación, active la casilla de
verificación de la columna Custom Reason.

• Para solicitar firmas electrónicas para el evento, seleccione la casilla de verificación
en la columna E-Signature.

• Para añadir una nota sobre la configuración de auditoría para este evento, escriba un
comentario en la columna Audit Record Comment.

9. Para guardar la configuración del mapa de auditoría, haga clic en Save.

Nota: Guarde el mapa de auditoría (con una extensión cam) en la subcarpeta Project
Information de la carpeta del proyecto en el que se utilizará.

El mapa de auditoría ya se puede utilizar con el proyecto o copiar en otro proyecto.
Consulte las secciones Aplicación de un mapa de auditoría o Copiar un mapa de
auditoría de otro proyecto.

Modificación de un mapa de auditoría
Los cambios se aplican solo al mapa de auditoría en el proyecto seleccionado. Las
configuraciones de auditoría integradas en las tablas de resultados no se pueden modificar.

PRECAUCIÓN: Posible pérdida de datos. No modifique un mapa de auditoría que esté
modificando otro usuario. Solo se conservarán los cambios que haya realizado la
última persona que ha guardado el mapa de auditoría.

1. Haga clic en View > Audit Trail Manager.
Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data.

3. Expanda la carpeta Projects.

4. En la sección Projects, haga clic en el proyecto que contiene el mapa de auditoría que
se debe modificar.

5. En la pestaña Settings, haga clic en Edit.
Se abrirá el cuadro de diálogo Audit Map Editor con el mapa de auditoría activo visible.

6. En la sección Projects, haga clic en el mapa de auditoría que se vaya a modificar.

7. En la tabla de mapa de auditoría, realice los cambios necesarios en la configuración.
Para obtener más información acerca de la tabla, haga clic en Help.

8. Para guardar el mapa de auditoría, haga clic en Save.
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Copiar un mapa de auditoría de otro proyecto
Los mapas de auditoría se pueden copiar de un proyecto a otro.

PRECAUCIÓN: Posible resultado erróneo. No copie los archivos cam (mapas de
auditoría) entre proyectos fuera del software Analyst MD, ya que esto puede causar
que las pistas de auditoría sean incorrectas.

1. Haga clic en View > Audit Trail Manager.
Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data.

3. Expanda la carpeta Projects.

4. En la sección Projects, haga clic en el proyecto en el que se copiará el mapa de
auditoría.

5. En la pestaña Settings, haga clic en Edit.
Se abrirá el cuadro de diálogo Audit Map Editor con el mapa de auditoría activo visible.

6. Haga clic en New.
El cuadro de diálogo Audit Map Editor mostrará un mapa de auditoría nuevo, sin
eventos auditados.

7. Haga clic en Copy From.
Se abrirá el cuadro de diálogo Open.

8. Busque y seleccione el archivo del mapa de auditoría que desee copiar y, a
continuación, haga clic en Open. Los archivos de mapas de auditoría tienen la
extensión cam y se almacenan en la carpeta Project Information de cada proyecto.
A continuación, se abrirá la configuración del mapa de auditoría seleccionado.

9. Haga clic en Save para guardar el mapa de auditoría copiado en el proyecto actual.

Aplicación de un mapa de auditoría
Cuando se aplica un mapa de auditoría a la pista de auditoría del instrumento o a la pista de
auditoría de un proyecto, este se convierte en el mapa de auditoría activo. La configuración
de auditoría del mapa de auditoría activo determina qué eventos se registran en las pistas
de auditoría.

El mapa de auditoría activo de un proyecto contiene la configuración de auditoría de la
pista de auditoría del proyecto y la configuración de auditoría de la pista de auditoría de
cuantificación de todas las tablas de resultados creadas.

1. Haga clic en View > Audit Trail Manager.
Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data y, a continuación, realice una
de las acciones siguientes:

• Para aplicar un mapa de auditoría a Instrument Audit Trail, haga clic en
Instrument.
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• Para aplicar un mapa de auditoría a un proyecto, expanda la carpeta Projects y, a
continuación, haga clic en el proyecto al que se aplicará el mapa de auditoría.

• Para especificar el mapa de auditoría activo predeterminado para nuevos proyectos,
expanda la carpeta Projects y, a continuación, haga clic en Default.

3. En el panel derecho, haga clic en la pestaña Settings.

4. En el campo Available Audit Trail Maps, haga clic en el mapa de auditoría que desee
aplicar.

5. Haga clic en Apply.

Ver, imprimir y buscar pistas de auditoría
En esta sección se proporciona información acerca de la visualización de pistas de auditoría,
pistas de auditoría archivadas y entradas del registro de mantenimiento de instrumentos.
También se proporcionan instrucciones para imprimir, buscar y ordenar registros de auditoría
en pistas de auditoría.

Ver pistas de auditoría
1. Haga clic en View > Audit Trail Manager.

Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data y, a continuación, realice una
de las acciones siguientes:

• Para ver una pista de auditoría del instrumento, haga clic en Instrument. Para
ver eventos específicos del instrumento, como las tablas de calibración de masas
reemplazadas, consulte la pista de auditoría del instrumento registrada en el equipo
que esté directamente conectado al espectrómetro de masas.

• Para ver la pista de auditoría del proyecto, expanda la carpeta Projects y después
haga clic en el proyecto que contenga la pista de auditoría.

• Para ver una pista de auditoría de cuantificación, expanda la carpeta Results
Tables , expanda la carpeta del proyecto correspondiente y, a continuación, haga
clic en el archivo Results Table de la pista de auditoría.

Sugerencia:

• Si un evento auditado hace referencia a un archivo wiff, abra el archivo wiff desde
Audit Trail. En la columna Change Description, haga clic en el vínculo al archivo.

• Para ver los datos de picos de la muestra utilizando el método de cuantificación y el
índice de la muestra almacenado en un registro de auditoría, abra la Results Table
correspondiente y, a continuación, en la columna History de la pista de auditoría,
haga clic en Review. Si el método de cuantificación ha cambiado con respecto al que
se utilizó al crear el registro de auditoría, es posible que se muestren resultados para
el pico distintos a los originales. Para ver los resultados originales, utilice la versión
adecuada del software.
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Ver la configuración de auditoría integrada en una tabla de
resultados
La configuración de auditoría utilizada para una tabla de resultados se integra en la tabla
de resultados durante su creación. No se puede modificar la configuración de auditoría
de una tabla de resultados. La marca de tiempo situada junto al mapa de auditoría
indica el momento en que se guardó por última vez el mapa de auditoría para integrar la
configuración.

1. Haga clic en View > Audit Trail Manager.
Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data.

3. Expanda la carpeta Results Tables.

4. En la sección Results Tables, expanda el proyecto que contenga la tabla de resultados
cuyo mapa de auditoría desee ver.

5. Haga clic en el archivo Results Table del que desee ver el mapa de auditoría.
La pista de auditoría se abrirá en el panel derecho.

6. En la pestaña Settings, haga clic en Details.

Se abrirá el cuadro de diálogo Results Table Audit Trail Settings con la configuración de
pista de auditoría de la tabla de resultados.

Ver detalles de un registro de auditoría en la pista del
instrumento
El usuario puede ver los detalles de los siguientes eventos auditados: cambios realizados en
la tabla de calibración de masas, cambios en la tabla de resoluciones o entradas del registro
de mantenimiento del instrumento.

1. Haga clic en View > Audit Trail Manager.
Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data.

3. En la sección Audit Trail Data, haga clic en Instrument. Si no se muestra la pista de
auditoría, haga clic en la pestaña History en el panel derecho.
Se abrirá la pista de auditoría.

4. Para ver otros registros que contengan detalles adicionales, haga clic en Review en la
columna History.

Ver pistas de auditoría archivadas
Cuando la pista de auditoría de un instrumento o un proyecto contiene 1000 registros de
auditoría, el software Analyst MD archiva automáticamente los registros y comienza una
nueva pista de auditoría. A los archivos de pistas de auditoría se les asigna un nombre
que contiene el tipo de pista de auditoría junto con la fecha y la hora, por ejemplo, PAT-
Archive-201609300820.ata.
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1. Haga clic en View > Audit Trail Manager.
Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data.

3. Expanda la carpeta Archive Files.

4. En la sección Archive Files, expanda el proyecto que contiene la pista de auditoría
archivada que se debe visualizar.

5. Haga clic en la pista de auditoría que desee ver.
La pista de auditoría archivada se abrirá en el panel derecho.

6. Si no se abre la pista de auditoría, haga clic en la pestaña History en el panel derecho.
Se abrirá la pista de auditoría.

Sugerencia: Como alternativa, abra una pista de auditoría archivada haciendo clic
con el botón derecho en el panel izquierdo y, a continuación, haciendo clic en Open
Archives. Se abrirá el cuadro de diálogo Open. Busque la carpeta del proyecto
correspondiente y, a continuación, en la carpeta Project Information, seleccione el
archivo de la pista de auditoría archivada. Estos archivos tienen la extensión ata.

Imprimir pistas de auditoría
1. Haga clic en View > Audit Trail Manager.

Se abre la ventana Audit Trail Manager.

2. Seleccione la pista de auditoría.

3. Haga clic con el botón derecho en la pestaña History, haga clic en Print y, a
continuación, realice una de las acciones siguientes:

• Para imprimir la página actual, haga clic en Current Page.

• Para imprimir todas las páginas de la pista de auditoría, haga clic en All Pages.

Buscar registros de auditoría
1. Haga clic en View > Audit Trail Manager.

Se abre la ventana Audit Trail Manager.

2. Seleccione la pista de auditoría.

3. Visualice la pista de auditoría que desee buscar.

4. Haga clic con el botón derecho en la pestaña History y, a continuación, haga clic en
Search.
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Figura 7-3: Cuadro de diálogo Audit Trail Search

5. Utilice la lista Display all records where y el campo Contains para elegir los registros
que se deben buscar.

6. Si es necesario, seleccione las fechas de inicio y fin en las listas Created between.

7. Haga clic en OK.
Tan solo aparecerán los registros que cumplan los criterios especificados.

Sugerencia: Para que se muestren todos los registros, haga clic en All. Para ordenar
los registros por orden numérico, alfabético o cronológico, haga clic en el título de la
columna correspondiente.
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Pistas de auditoría A
Esta sección incluye listas de todos los eventos auditados que están guardados en las pistas
de auditoría del instrumento, del proyecto y de la cuantificación.

Para cada cambio auditado realizado en un archivo o evento auditado, se almacena la
siguiente información:

• Número de registro

• Fecha y hora

• Nombre de usuario

• Nombre completo del usuario

• Módulo de software Analyst MD

• Descripción del cambio

• Motivo del cambio, si es necesario

• Firma electrónica, si es necesaria

Registros de pistas de auditoría
Los archivos de pistas de auditoría del instrumento, del proyecto y de cuantificación son
archivos cifrados. Todos los archivos de pistas de auditoría se almacenan en los directorios
del proyecto, en el directorio principal.

Para cada cambio auditado realizado en un archivo o evento auditado, se almacena la
siguiente información:

• Número de registro

• Fecha y hora

• Nombre de usuario

• Nombre completo del usuario

• Módulo de software Analyst MD

• Descripción del cambio

• Motivo del cambio, si es necesario

• Firma electrónica, si es necesaria

Archivos de pistas de auditoría
Los registros de auditoría se almacenan en los archivos de pistas de auditoría del
instrumento y del proyecto y pueden crear archivos de gran tamaño difíciles de consultar y
gestionar. Los archivos de pistas de auditoría de cuantificación suelen contener una cantidad
inferior de registros, más fácil de gestionar.
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Cuando los archivos de pistas de auditoría del instrumento o del proyecto alcanzan los 1000
registros, se agrega un registro final en el que se indica que el archivo se ha archivado.
La pista de auditoría se guarda automáticamente en la carpeta Project Information y se le
asigna un nombre que indica el tipo de pista de auditoría del que se trata, junto con la fecha
y la hora (por ejemplo, "PAT-Archive-201609300820.ata"). A continuación, se crea una
pista de auditoría del instrumento o del proyecto nueva y el primer registro incluye la ruta de
la pista de auditoría archivada.

Eventos de pista de auditoría del instrumento
Cada ordenador tiene una pista de auditoría del instrumento. En esta se registran eventos,
como elementos agregados o reemplazados en las tablas de resoluciones de calibración de
masas, cambios en la configuración del sistema, eventos de seguridad y entradas realizadas
en el registro de mantenimiento del instrumento. En el caso de los equipos que están
directamente conectados a un espectrómetro de masas, la pista de auditoría del instrumento
tan solo registra eventos de seguridad.

La pista de auditoría del instrumento registra los siguientes eventos:

• Sustitución de tablas de calibración de masas.

• Adición de tablas de calibración de masas.

• Sustitución de tablas de resoluciones.

• Adición de tablas de resolución.

• Activación del perfil de hardware.4

• Desactivación del perfil de hardware.4

• Acceso al registro de mantenimiento de un instrumento.

• Envío de archivos de lotes.4

• Envío de muestras para su adquisición.4

• Desplazamiento de la muestra de la posición X a la posición Y del archivo de lotes.4

• Desplazamiento del lote.4

• Readquisición de muestras.4

• Modificación de tablas de calibración de masas y tablas de resoluciones.

• Sustitución de tablas de resoluciones (sin confirmación).4

• Modificación de la configuración del instrumento.

• Autorización de calibración del instrumento.

• Sustitución de tablas de calibración de masas.4

• Inicio de sesión de usuario.4

• Cierre de sesión de usuario.4

• Error de inicio de sesión de usuario.4

4 Este evento no se puede auditar con un motivo. Es posible auditarlo en silencio o no auditarlo.
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• Notificación enviada por la función de seguridad.4

• Modificación de la configuración de seguridad.4

• Restablecimiento del contador del conmutador de válvula doble.

• Adición de un usuario.4

• Eliminación de un usuario.4

• Adición de un tipo de usuario.4

• Eliminación de un tipo de usuario.4

• Modificación del tipo de usuario.4

• Modificación del modo de usuario.4

• Modificación del tipo de usuario realizada por el usuario.4

• Modificación de la cuenta de adquisición.4

• Modificación del bloqueo de la pantalla.4

• Modificación del cierre de sesión.4

• Adición de un instrumento.4

• Eliminación de un instrumento.4

• Adición de una función del proyecto.4

• Modificación de una función del proyecto.4

• Eliminación de una función del proyecto.4

• Modificación de seguridad del proyecto.4

• Modificación de la configuración de ajustes.4

Eventos de pista de auditoría del proyecto
Cada proyecto dispone de una pista de auditoría del proyecto. Esta pista registra eventos
como la creación, modificación y eliminación de archivos de proyectos, datos, cuantificación,
métodos, lotes, ajustes, tablas de resultados y plantillas de informe, así como eventos de
apertura, cierre e impresión de módulos.

La pista de auditoría del proyecto puede registrar los siguientes eventos:

• Creación de un mapa de auditoría.5

• Modificación de un mapa de auditoría.5

• Eliminación de un mapa de auditoría.5

• Creación de un archivo de lotes.6

• Modificación de un archivo de lotes.6

5 Este evento siempre se audita de forma silenciosa y no se muestra en el cuadro de diálogo Audit Map
Editor.

6 Este evento no se puede auditar con un motivo. Es posible auditarlo en silencio o no auditarlo.
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• Creación de un archivo de plantilla de lotes.6

• Creación de un archivo de datos.6

• Creación de un archivo de métodos de cuantificación.6

• Modificación de un archivo de métodos de cuantificación.6

• Creación de una tabla de resultados de cuantificación.6

• Modificación de una tabla de resultados de cuantificación.6

• Creación de un archivo de plantilla de informe.

• Modificación de un archivo de plantilla de informe.

• Creación de un archivo de métodos de adquisición.

• Modificación de un archivo de métodos de adquisición.

• Acceso al módulo.6

• Cierre del módulo.6

• Adición de una muestra a un archivo de datos.6

• Impresión en curso de un documento en la impresora.

• Impresión finalizada de un documento en la impresora.6

• Apertura de un archivo de datos.6

• Almacenamiento de archivos del historial de análisis.

• Almacenamiento de un archivo de datos procesado.

• Archivo de suma de comprobación.6

• Modificación de la configuración del proyecto.7

• Modificación del algoritmo de procesamiento.6

Eventos de pista de auditoría de cuantificación
En todos los archivos de tablas de resultados se almacena una pista de auditoría de
cuantificación. Al crear una tabla de resultados, el mapa de auditoría activo se guarda en el
archivo de la tabla de resultados para utilizarlo con la pista de auditoría de cuantificación.
Este mapa de auditoría integrado no se puede cambiar durante la creación de la tabla de
resultados. Todos los cambios realizados en la tabla de resultados se auditan conforme al
mapa de auditoría integrado. Los cambios realizados en el mapa de auditoría activo (dentro
del proyecto) no se actualizan en las tablas de resultados existentes. Sin embargo, las tablas
de resultados nuevas sí utilizarán el mapa de auditoría activo modificado.

La descripción de un evento de pista de auditoría de cuantificación incluye la operación
realizada en los datos, por ejemplo, los puntos eliminados de una calibración, los ajustes
automáticos y manuales iniciales y los cambios realizados en el ajuste de la curva.

7 Este evento siempre se audita.
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En una pista de auditoría de cuantificación, los registros de auditoría relacionados con
la integración de picos de la muestra contienen información adicional. Estos registros
incluyen los parámetros de procesamiento de cuantificación más recientes asociados con
cada muestra de la tabla de resultados. Por ejemplo, la pista de auditoría de una tabla
de resultados puede incluir los parámetros utilizados para todas las correcciones manuales
realizadas en las integraciones de picos automáticas.

La pista de auditoría de cuantificación puede registrar los siguientes eventos:

• Actualización del método de cuantificación.

• Restablecimiento del pico de cuantificación original.

• Integración del pico de cuantificación.

• Creación de una tabla de resultados.

• Modificación del método de cuantificación.

• Adición de archivos a la tabla de resultados.

• Eliminación de archivos de la tabla de resultados.

• Acceso del revisor de control de calidad a la tabla de resultados.

• Almacenamiento de la tabla de resultados.

• Eliminación de entradas de la pista de auditoría de la tabla de resultados.

• Modificación del valor del campo «Use IT».

• Modificación del valor del campo «Sample Name».

• Modificación del valor del campo «Sample ID».

• Modificación del valor del campo «Sample Type».

• Modificación del valor del campo «Sample Comment».

• Modificación del valor del campo «Sample Annotation».

• Modificación del valor del campo «Weight to Volume Ratio».

• Modificación del valor del campo «Dilution Factor».

• Modificación del valor del campo «Concentration».

• Modificación del valor del campo «Analyte Annotation».

• Modificación de la columna de la fórmula.

• Modificación del nombre de la fórmula.

• Modificación de la cadena de la fórmula

• Eliminación de la columna de la fórmula.

• Modificación del título en «Custom Title».

• Adición/eliminación de muestras.
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Pista de auditoría de la AAC
A cada servidor de la Analyst Administrator Console (AAC) le corresponde una pista de
auditoría. Esta función no se admite en el software Analyst MD.
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Personalización adicional de la
seguridad B
Esta sección contiene información sobre las funciones adicionales que proporciona el
software Analyst MD para proteger los datos.

Modificaciones realizadas en los archivos de
datos (procesamiento de exploración)
El historial de procesamiento de exploración es un archivo que contiene un registro de los
cambios realizados en los parámetros de procesamiento utilizados con un archivo de datos.
Estos registros se deben crear manualmente para llevar un seguimiento de los cambios
realizados. Solo se guardan los cambios actuales. Una vez creado un archivo de Historial
de procesamiento de exploración, no puede modificarse ni borrarse dentro del software
Analyst MD.

Una vez guardado el historial de los cambios realizados en un archivo de datos, puede
utilizar dicho historial para consultar el archivo de datos correspondiente a cualquiera de los
cambios realizados. Los usuarios no pueden modificar ni guardar una versión anterior del
archivo de datos del historial.

Los archivos de historial de procesamiento de exploración registran los siguientes
parámetros:

• Suavizado/peso del punto anterior.

• Suavizado/peso del punto actual.

• Suavizado/peso del punto siguiente.

• Suavizado gaussiano/anchura del filtro.

• Suavizado gaussiano/distancia.

• Opciones de centroide/combinar distancia.

• Opciones de centroide/anchura mínima.

• Opciones de centroide/utilizar pico máximo para el valor X.

• Sustracción de línea de referencia/anchura de las ventanas.

• Límite

• Filtro de ruido/anchura mínima del pico.

• Cromatograma de picos base/tolerancia de la masa.

• Añadir

• Sustraer
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Crear archivos de historial de procesamiento de
exploración
Los archivos de historial de procesamiento de exploración (.eph) no se pueden modificar ni
eliminar dentro del software Analyst MD.

En el modo Explore, haga clic con el botón derecho en un panel de archivos de datos
y, a continuación, haga clic en Save Explore History. Los archivos de historial de
procesamiento de exploración se almacenan en la subcarpeta Processing Methods de la
carpeta del proyecto.

Sugerencia: Para facilitar el seguimiento de los archivos de historial de procesamiento de
exploración, guarde el archivo de historial con un nombre similar al del archivo de datos.

Ver un archivo de historial de procesamiento de
exploración
1. Haga clic en File > Open.

Se abrirá el cuadro de diálogo Open.

2. En la lista Files of type, haga clic en Explore History Files (eph).

3. En el campo Files, haga clic en el archivo y, a continuación, haga clic en OK.
Se abrirá el archivo wiff con el archivo de historial de procesamiento de exploración en
el panel inferior.

4. Para mostrar el archivo wiff utilizando los parámetros de procesamiento en la pestaña
de historial, haga clic en Review en la columna History.

5. Para imprimir la ventana Explore Processing , haga clic con el botón derecho en la
pestaña History, haga clic en Print y, a continuación, haga clic en Current Page o en
All Pages.

6. Para mostrar el historial de procesamiento de datos actual de un archivo de datos en
el panel activo, en el modo Explore, haga clic en Explore > Show > Show History.
El historial que se muestra no se guarda automáticamente y no se puede utilizar para
revisar el procesamiento.

Agregar una entrada al registro de mantenimiento del
instrumento
Cuando se llevan a cabo operaciones relacionadas con el espectrómetro de masas, como el
mantenimiento, la limpieza y las comprobaciones de referencias del sistema, debe registrar
la información de mantenimiento en la pista de auditoría del instrumento mediante el registro
de mantenimiento del instrumento.

1. Haga clic en View > Audit Trail Manager.
Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data.

3. En la sección Audit Trail Data, haga clic en Instrument.
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4. En el panel derecho, abra la pestaña Maintenance Log.

5. Escriba la información de mantenimiento en los campos correspondientes.

6. Para guardar la entrada del registro, haga clic en Submit.

Ver una entrada del registro de mantenimiento del
instrumento
1. Haga clic en View > Audit Trail Manager.

Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo, expanda la carpeta Audit Trail Data.

3. En la sección Audit Trail Data, haga clic en Instrument.

4. Si no se muestra la pista de auditoría, abra la pestaña History en el panel derecho.
Se abrirá la pista de auditoría.

5. Para ver el registro de la entrada de mantenimiento del instrumento, haga clic en
Review en la columna History.
Se abrirá el cuadro de diálogo Audit Trail History con los detalles de la entrada del
registro.

Sugerencia: Para buscar todas las entradas de registro de la pista de auditoría del
instrumento, haga clic en Search. En el cuadro de diálogo Audit Trail Search, utilice las
opciones correspondientes para mostrar todos los registros en los que la descripción
especificada en Change Description contenga Instrument Maintenance.

Configuración de notificaciones de correo electrónico
El software Analyst MD se puede configurar para enviar un mensaje de correo electrónico si
se producen tres errores de inicio de sesión en el transcurso de un día. Esta notificación de
correo electrónico solo está disponible si el software se encuentra en el modo integrado
o mixto. Para obtener información sobre los modos de seguridad, consulte la sección
Analyst MD y sistema de seguridad de Windows: funcionamiento conjunto.

El destinatario del mensaje de correo electrónico debe tener acceso a una cuenta válida
de un servidor de correo compatible con SMTP, y el ordenador en el que esté instalado el
software Analyst MD debe tener acceso a un servidor SMTP.

1. Haga clic en View > Audit Trail Manager.
Se abre la ventana Audit Trail Manager.

2. En el panel izquierdo haga clic con el botón derecho en la ventana Audit Trail Manager,
haga clic en Options y, a continuación, haga clic en E-Mail Notification Settings.
Se abrirá el cuadro de diálogo Audit Trail Options con la pestaña Security Mail Settings
seleccionada.

3. Seleccione la casilla Send e-mail message(s) after 3 logon failures within 24hr..

4. En el campo SMTP Server, escriba el nombre del servidor SMTP.
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Nota: La cuenta SMTP enviará un correo al servidor de correo electrónico. Utilice la
aplicación de correo electrónico para determinar el servidor SMTP.

5. En el campo Port Number , escriba el número de puerto.
Si pulsa el botón Default, se introducirá el número de puerto predeterminado, que es el
25.

6. En el campo To, escriba la dirección de correo electrónico a la que se debe enviar el
mensaje. Por ejemplo: nombreusuario@dominio.com.

7. En el campo From, escriba el nombre que desee que aparezca en el campo From del
mensaje. Por ejemplo, escriba el nombre del ordenador para mantener un registro del
ordenador en el que se han producido los fallos de inicio de sesión. En valor del campo
From no puede contener espacios.

8. En el campo Subject, escriba el asunto del mensaje.

9. En el campo Message, escriba el cuerpo del mensaje.

10. Para comprobar la configuración, haga clic en Send Test Mail.

11. Para guardar la configuración, haga clic en OK.

Nota: Si no se reciben las notificaciones de correo electrónico en la carpeta Inbox,
compruebe si están en la carpeta Junk E-mail.

Sugerencia: Para desactivar la notificación por correo electrónico, desmarque la casilla
de verificación Send email message(s) after 3 logon failures within 24hr..

Suma de comprobación de archivos de datos
Recomendamos que el usuario utilice sumas de comprobación de archivos de datos. La
función de suma de comprobación es una comprobación de redundancia cíclica para
verificar la integridad del archivo de datos. La función de suma de comprobación está
activada de forma predeterminada para una instalación nueva del software Analyst MD.
Si los usuarios actualizan a la versión actual del software Analyst MD, se mantiene su
configuración de suma de comprobación antes de la actualización.

La función de suma de comprobación se debe utilizar si el espectrómetro de masas se
emplea como dispositivo de diagnóstico in vitro.

Si la función de suma de comprobación de archivos de datos está activada, siempre
que el usuario crea un archivo de datos (wiff), el software genera un valor de suma de
comprobación utilizando un algoritmo basado en el algoritmo de cifrado público MD5 y
guarda el valor en el archivo. Al verificar la suma de comprobación, el software calcula dicha
suma y compara este cálculo con la suma de comprobación almacenada en el archivo.

La comparación de las sumas de comprobación puede tener tres resultados:

• Si los valores coinciden, significa que la suma de comprobación es válida.

• Si los valores no coinciden, significa que la suma de comprobación no es válida. Una
suma de comprobación no válida indica que el archivo se ha modificado fuera del
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software o que se ha guardado con la función de cálculo de la suma de comprobación
habilitada y esta suma difiere de la suma de comprobación original.

• Si el archivo no contiene un valor de suma de comprobación, no será posible encontrarla.
Cuando un archivo no contiene un valor de suma de comprobación almacenado, se debe
a que el archivo se ha guardado con la función de suma de comprobación de archivos de
datos deshabilitada.

Verificar la suma de comprobación de archivos de datos
Siempre que se abre un archivo de datos, el usuario puede verificar la suma de
comprobación. En esta sección se describen los pasos para verificar una suma de
comprobación, así como para habilitar y deshabilitar la función de suma de comprobación de
archivos de datos.

El cálculo de la suma de comprobación puede tardar más de un minuto con archivos de
datos grandes. Durante la adquisición, la suma de comprobación del archivo que se va a
crear no se puede verificar.

1. Haga clic en File > Open Data File.
Se abrirá el cuadro de diálogo Select Sample.

2. En el campo Data Files, seleccione un archivo de datos (wiff).

3. Haga clic en Verify Checksum.

Se abre el cuadro de diálogo de mensaje ExplorDir, donde se muestra el resultado de
la comparación de la suma de comprobación como Valid, Invalid o Not found (válida, no
válida o no encontrada).

Cómo habilitar o deshabilitar la función de suma de
comprobación de archivos de datos
El software Analyst MD indica si la función de suma de comprobación de archivos de datos
está habilitada mediante una marca de verificación junto al comando del menú de accesos
directos del gestor de pistas de auditoría.

1. Haga clic en View > Audit Trail Manager.
Se abre la ventana Audit Trail Manager.

2. Haga clic con el botón derecho en el panel izquierdo de la ventana Audit Trail Manager
y, a continuación, haga clic en Options.

3. Haga clic en Data File Checksum.
Si la función de suma de comprobación de archivos de datos está activada, se muestra
una marca de verificación junto al comando. Si la función de suma de comprobación de
archivos de datos está desactivada, la marca de verificación desaparece.
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Cuenta de adquisición especial C
Nota: SCIEX no admite el uso de la función de adquisición de red con el software
Analyst MD.

En un entorno regulado en el que se adquieren datos en una carpeta de red, la mayoría
de los usuarios normalmente no tienen derechos de eliminación para la carpeta de destino.
Esto puede causar problemas porque el software Analyst MD requiere acceso de eliminación
para adquirir correctamente los datos en una carpeta de red.

La función de cuenta de adquisición especial (SAA) permite la adquisición de red en un
entorno de red cerrado otorgando derechos de eliminación solo a AnalystService. Para
activar esta función, el administrador del laboratorio crea una cuenta con permiso de control
total para las carpetas adecuadas y, a continuación, especifica esa cuenta en el grupo
Special Acquisition Administrator Account en el cuadro de diálogo Security Configuration
del software Analyst MD. De ese modo, el software Analyst MD puede adquirir datos
correctamente, aunque la mayoría de los usuarios no tengan derechos de eliminación. Para
obtener información sobre la selección de una cuenta de adquisición, consulte la sección
Seleccionar una cuenta de adquisición.

La SAA debe tener:

• Permiso de control total (recomendado) o de modificación (mínimo) para la carpeta de
datos del servidor.

• Permiso de control total (recomendado) o de modificación (mínimo) para la carpeta
WIFF_CACHE_BACKUP.

No es necesario que la SAA:

• Pertenezca al grupo de administradores del ordenador.

• Pertenezca al grupo de usuarios Analyst Administrator Console (AAC), al grupo de
trabajo de administradores de consola o a cualquier otro grupo de trabajo.

• Esté en la base de datos de seguridad del software Analyst MD.
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Contacto

Formación del cliente
• En América del Norte: NA.CustomerTraining@sciex.com

• En Europa: Europe.CustomerTraining@sciex.com

• Fuera de la UE y América del Norte, visite sciex.com/education para obtener información
de contacto.

Centro de aprendizaje en línea
• SCIEX Now Learning Hub

Soporte SCIEX
SCIEX y sus representantes cuentan con un equipo de especialistas técnicos y de servicio
totalmente cualificados en todo el mundo. Ellos sabrán resolver sus dudas y preguntas sobre
el sistema y cualquier problema técnico que pueda surgir. Para obtener más información,
visite el sitio web de SCIEX en sciex.com o póngase en contacto con nosotros de una de las
siguientes formas:

• sciex.com/contact-us

• sciex.com/request-support

Ciberseguridad
Para obtener las indicaciones sobre ciberseguridad más recientes para los productos
SCIEX, visite sciex.com/productsecurity.

Documentación
Esta versión del documento sustituye a todas las versiones anteriores de este documento.

Para ver este documento electrónicamente se necesita Adobe Acrobat Reader. Para
descargar la última versión, vaya a https://get.adobe.com/reader.

Para buscar la documentación relacionada con el producto de software, consulte las notas
de la versión o la guía de instalación del software que se suministra con el software.

Para localizar la documentación relacionada con los productos de hardware, consulte el
DVD Customer Reference que se suministra con el sistema o componente.

Nota: Para solicitar una versión impresa y gratuita de este documento, póngase en contacto
con sciex.com/contact-us.
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